EC-211- COMPUTER APPLICATIONS IN PHYSICAL EDUCATION  
		UNIT-I
What is a Computer?
 A computer is a programmable machine designed to perform arithmetic and logical operations automatically and sequentially on the input given by the user and gives the desired output after processing. Computer components are divided into two major categories namely hardware and software. Hardware is the machine itself and its connected devices such as monitor, keyboard, mouse etc. Software are the set of programs that make use of hardware for performing various functions. 
What Is ICT?
ICT (information and communications technology - or technologies) is an umbrella term that includes any communication device or application, encompassing: radio, television, cellular phones, computer and network hardware and software, satellite systems and so on, as well as the various services and applications associated with them, such as videoconferencing and distance learning. ICTs are often spoken of in a particular context, such as ICTs in education, health care, or libraries. 
Need and Importance of ICT
ICT to improve student learning:
1. ICT should be utilised selectively within the learning context and should focus upon improving students’ understanding and enthusiasm. The prime goal must reside with effective teaching and learning with ICT contributing to such a dynamic process.

2. It is important to remember that ICT is not a tool for learning but a medium for delivering pre-determined content. Lessons must be avoided where students simply search for and retrieve information with no prior learning outcomes being set by the teacher.

3. ICT allows the teacher to reconsider teaching and learning and frees the teaching from the constraints of the classroom and traditional teaching strategies. ICT is appealing to students and must surely be the preferred learning mode, given that the computer is often viewed as the ‘child’s machine’. If learning materials are designed around technologies, the student should be motivated by such opportunities
The integration of ICT should promote and enhance learning by: 
• Accessibility – bringing the world to the classroom.
 • Involvement with technologies distinct from conventional methods.
 • Accommodating the various paces of learning.
 • Encouraging students to access and evaluate information from various sources.

Teaching strategies can be varied when integrating ICT and consideration should be given to: 
• Group work 
• The operation of a cascade model whereby competent students are able to assist others in the use of ICT 
• The limitations posed by a single screen when teaching the whole class.

Technologies in Physical Education ICT incorporate a vast array of hardware and software. The following technologies should be considered for use within PE for planning, administrative and teaching purposes: 
• Internet – A global network providing the capability to communicate, share ideas and access information and resources from around the globe. 
• Intranet – Similar to the Internet, but information from within a school or organization.
 • CD-ROM – Information is presented in the form of graphics and text with sound and moving video.
 • Wristwatch/heart rate monitors – Usually a strap fits around the chest and contains a radio to transmit the heartbeat to the monitor in the wristwatch. 
• Digital camera – The pictures taken are stored in computer memory rather than on film as in an ordinary camera. They can be displayed directly onto the computer monitor or imported into a graphics/art package for editing.
 • Generic software – The most common forms are word processors and spreadsheets.
 • Video capture – A video camera which can be connected to the computer. Video sequences or still images can be stored on disk and edited.
 • Data handling – Information can be stored in a database.
 • Desktop publishing – A combination of text, graphics and layout to produce a document. 
• Presentation software – For example, Microsoft® PowerPoint – software displaying information in slide form


COMPONENTS OF COMPUTER, INPUT AND OUTPUT DEVICE:

A computer system consists of mainly four basic units; namely input unit, storage unit, central processing unit and output unit. Central Processing unit further includes Arithmetic logic unit and control unit, as shown in the figure:. A computer performs five major operations or functions irrespective of its size and make. These are
• it accepts data or instructions as input,
• it stores data and instruction
• it processes data as per the instructions,
• it controls all operations inside a computer, and
• it gives results in the form of output.
Functional Units:
a. Input Unit: This unit is used for entering data and programs into the computer system by the user for processing.
b. Storage Unit: The storage unit is used for storing data and instructions before and after processing.
c. Output Unit: The output unit is used for storing the result as output produced by the computer after processing.
d. Processing: The task of performing operations like arithmetic and logical operations is called processing. The Central Processing Unit (CPU) takes data and instructions from the storage unit and makes all sorts of calculations based on the instructions given and the type of data provided. It is then sent back to the storage unit. CPU includes Arithmetic logic unit (ALU) and control unit (CU)
Computer Chip
• Arithmetic Logic Unit: All calculations and comparisons, based on the instructions provided, are carried out within the ALU. It performs arithmetic functions like addition, subtraction, multiplication, division and also logical operations like greater than, less than and equal to etc.
	


• Control Unit: Controlling of all operations like input, processing and output are performed by control unit. It takes care of step by step processing of all operations in side the computer.
Memory
Computer’s memory can be classified into two types; primary memory and secondary memory
RAM
a. Primary Memory can be further classified as RAM and ROM.
• RAM or Random Access Memory is the unit in a computer system. It is the place in a computer where the operating system, application programs and the data in current use are kept temporarily so that they can be accessed by the computer’s processor. It is said to be ‘volatile’ since its contents are accessible only as long as the computer is on. The contents of RAM are no more available once the computer is turned off.

ROM or Read Only Memory is a special type of memory which can only be read and contents of which are not lost even when the computer is switched off. It typically contains manufacturer’s instructions. Among other things, ROM also stores an initial program called the ‘bootstrap loader’ whose function is to start the operation of computer system once the power is turned on.
b. Secondary Memory
RAM is volatile memory having a limited storage capacity. Secondary/auxiliary memory is storage other than the RAM. These include devices that are peripheral and are connected and controlled by the computer to enable permanent storage of programs and data.
· CD ROM
Secondary storage devices are of two types; magnetic and optical. Magnetic devices include hard disks and optical storage devices are CDs, DVDs, Pen drive, Zip drive etc.
• Hard Disk
Hard disks are made up of rigid material and are usually a stack of metal disks sealed in a box. The hard disk and the hard disk drive exist together as a unit and is a permanent part of the computer where data and programs are saved. These disks have storage capacities ranging from 1GB to 80 GB and more. Hard disks are rewritable.
• Compact Disk
Compact Disk (CD) is portable disk having data storage capacity between 650-700 MB. It can hold large amount of information such as music, full-motion videos, and text etc. CDs can be either read only or read write type.
CD Drive
• Digital Video Disk
Digital Video Disk (DVD) is similar to a CD but has larger storage capacity and enormous clarity. Depending upon the disk type it can store several Gigabytes of data. DVDs are primarily used to store music or movies and can be played back on your television or the computer too. These are not rewritable.

Hard Disk
Input / Output Devices:
These devices are used to enter information and instructions into a computer for storage or processing and to deliver the processed data to a user. Input/Output devices are required for users to communicate with the computer. In simple terms, input devices bring information INTO the computer and output devices bring information OUT of a computer system. These input/output devices are also known as peripherals since they surround the CPU and memory of a computer system.
Input Devices
An input device is any device that provides input to a computer. There are many input devices, but the two most common ones are a keyboard and mouse. Every key you press on the keyboard and every movement or click you make with the mouse sends a specific input signal to the computer.
Keyboard
• Keyboard: The keyboard is very much like a standard typewriter keyboard with a few additional keys. The basic QWERTY layout of characters is maintained to make it easy to use the system. The additional keys are included to perform certain special functions. These are known as function keys that vary in number from keyboard to keyboard.
• Mouse: A device that controls the movement of the cursor or pointer on a display screen. A mouse is a small object you can roll along a hard and flat surface. Its name is derived from its shape, which looks a bit like a mouse. As you move the mouse, the pointer on the display screen moves in the same direction.
• Trackball: A trackball is an input device used to enter motion data into computers or other electronic devices. It serves the same purpose as a mouse, but is designed with a moveable ball on the top, which can be rolled in any direction.
• Touchpad: A touch pad is a device for pointing (controlling input positioning) on a computer display screen. It is an alternative to the mouse. Originally incorporated in laptop computers, touch pads are also being made for use with desktop computers. A touch pad works by sensing the user’s finger movement and downward pressure. • Touch Screen: It allows the user to operate/make selections by simply touching the display screen. A display screen that is sensitive to the touch of a finger or stylus. Widely used on ATM machines, retail point-of-sale terminals, car navigation systems, medical monitors and industrial control panels.

Mouse
• Light Pen: Light pen is an input device that utilizes a light-sensitive detector to select objects on a display screen.
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• Magnetic ink character recognition (MICR): MICR can identify character printed with a special ink that contains particles of magnetic material. This device particularly finds applications in banking industry.
• Optical mark recognition (OMR): Optical mark recognition, also called mark sense reader is a technology where an OMR device senses the presence or absence of a mark, such as pencil mark. OMR is widely used in tests such as aptitude test.
• Bar code reader: Bar-code readers are photoelectric scanners that read the bar codes or vertical zebra strips marks, printed on product containers. These devices are generally used in super markets, bookshops etc.
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Scanner
Scanner is an input device that can read text or illustration printed on paper and translates the information into a form that the computer can use. A scanner works by digitizing an image. (Fig. 1.7)

Scanner
Output Devices:
Output device receives information from the CPU and presents it to the user in the desired from. The processed data, stored in the memory of the computer is sent to the output unit, which then converts it into a form that can be understood by the user. The output is usually produced in one of the two ways – on the display device, or on paper (hard copy).
•Monitor: is often used synonymously with “computer screen” or “display.” Monitor is an output device that resembles the television screen (fig. 1.8). It may use a Cathode Ray Tube (CRT) to display information. The monitor is associated with a keyboard for manual input of characters and displays the information as it is keyed in. It also displays the program or application output. Like the television, monitors are also available in different sizes. • Printer: Printers are used to produce paper (commonly known as hard copy) output. Based on the technology used, they can be classified as Impact or Non-impact printers.
Impact printers use the typewriting printing mechanism wherein a hammer strikes the paper through a ribbon in order to produce output. Dot-matrix and Character printers fall under this category.
Monitor
Non-impact printers do not touch the paper while printing. They use chemical, heat or electrical signals to etch the symbols on paper. Inkjet, Deskjet, Laser, Thermal printers fall under this category of printers.
• Sound cards and Speaker(s): An expansion board that enables a computer to manipulate and output sounds. Sound cards are necessary for nearly all CD-ROMs and have become commonplace on modern personal computers. Sound cards enable the computer to output sound through speakers connected to the board, to record sound input from a microphone connected to the computer, and manipulate sound stored on a disk.


Examples of ICT applications that can be used in physical education

The following applications are considered below:
1. Cameras
2. Mobile phone cameras
3. Motion analysis software
4. Film editing
5. Portable media players
6. Interactive whiteboards
7. Voice projections systems
8. Developing FUNctional skills through physical education
9. Games consoles
10. Nintendo Wii Fit
11. Dance mat systems
12. Pedometers
13. Pupil response systems
14. Archos
15. The use of iPods
16. Podcasting
17. The Virtual Learning Environment (VLE)
18. Video conferencing
19. Youtube

Cameras
There are a range of hardware applications that can be used with physical education departments. Video cameras can provide footage of experienced performers in action and can be used to inspire, to demonstrate correct techniques and to develop pupils’ understanding and knowledge of the subject. By reviewing their own actions, for example, pupils can evaluate and improve their own games strategies, gymnastics sequences, trampolining routines or dance compositions, particularly if they are able to look at their performances in slow motion or from a different viewing angle.

Within practical situations the use of still and video cameras can highlight personal achievement within lessons. Video footage and photographic images can be cropped and edited and used either a slideshow or highlight DVD. Cameras can also be used as an assessment for learning tool and as a form of classroom management. Furthermore, they can help to create activity cards, worksheets, presentations as well as enable a teacher to break a particular skill or technique down to reinforce learning and demonstrate and show good practice. One example of a useful camera is the Sanyo Xacti video camera which is waterproof and captures footage as a regular video camera would. The storage is through SD memory cards and this allows for easy transfer of data. Footage taken can be observed through a PC, via the interactive whiteboard. The camera is incredibly simple to use and it has a reasonable battery life. The Xacti can been used to capture footage of performances in physical education lessons.

Mobile camera phones
The use of mobile phones in schools is a contentious issue. Some schools may allow pupils to use their mobile phones within physical education lessons. For example, during an orienteering unit of work pupils can take photographs with their phones of the items they were trying to find and use the picture as evidence of completion of the course. Pupils can also set up their own orienteering courses, using their pictures taken with their phones and transferred to the computers within the lesson. Other groups can then have the opportunity to attempt various different courses which could be an excellent way to integrate ICT and literacy into physical education. This could especially work well if there is minimal ICT equipment within the department.

Motion analysis software	
The use of motion analysis software within physical education is becoming a more mainstream means of evaluating pupil performance and enhancing learning. There are many software packages available. Software such as ‘dartfish’ can provide pupils with visual images of their performances that can be slowed down but also enlarged. This allows teachers, using a digital camera, to split the screen into progressive frames and is therefore useful for highlighting techniques in some of the athletic field events or trampolining routines. Freeze-framing and overlay facilities are also a useful application. The footage can be saved and stored for moderation purposes. Whilst there are certain advantages in using this type of software there are also some disadvantages. (www.dartfish.com)

Film editing in PE
Video footage taken in one lesson can be edited and used at the beginning of the following lesson to highlight the achievements of pupils but also to identify common faults. This enables teachers and pupils to study individual and team performance across a range of activities. Teachers and pupils can compile footage taken from all the different lessons and use the footage to show other pupils in different classes what to expect using film-editing software. It is imperative, however, that you understand the issues involved in using moving and still images of pupils and that school policies and protocols are adhered to when using ICT to record pupil performance. This includes issues associated with parental permission; filming for a purpose, 

Portable multimedia players 
Portable multimedia players (PMP), sometimes referred to as a portable video player (PVP) or an Internet Media Tablet (IMT), are capable of storing and playing digital media. Digital Audio Players (DAP) that can also display images and play videos are portable multimedia players. Like DAPs, the data is typically stored on a hard drive. Micro drive or flash memory. Other types of electronic devices like mobile phones are sometimes referred as PMPs because of their playback capabilities. Below are some specific examples of multimedia players and how they can be used in physical education lessons to support teaching and leaning.

Interactive whiteboards
An interactive whiteboard is a surface onto which a computer screen can be displayed through a data projector. As it is touch-sensitive it allows teachers to use a pen or finger like a mouse to control the computer from the board and save any changes for future lessons. In addition, multimedia resources can be used as well access to the internet and websites to support teaching and learning. Interactive whiteboards are a useful teaching aid in classroom-based lessons as they can support learning through presentations, demonstrations and modelling, actively engage pupils and improve the pace and flow of lessons. A laptop computer that is linked to a data projector can also enable you to use this type of resource in a sports hall or gym. Teachers can use interactive whiteboards for showing a whole class a particular technique from video demonstrations taken immediately afterwards or in a previous lesson
Voice projection systems
The use of voice projection systems are an innovative way of communicating with pupils specifically within physical education. The FrontRow To Go system is one example of a portable voice projection that can be used wherever you teach. The system includes a lightweight, wireless hand-held radio microphone and head microphone which transmits a teacher’s voice to a base-station. This then amplifies, enhances speech frequencies and broadcasts the voice from speakers to the whole class. It is simple to set up and very effective. The system can be used either from a mains electrical socket or has rechargeable batteries giving over six hours of power. The system can increase pupil attentiveness and concentration, improve teaching and learning and reduces voice strain. 
Developing Functional skills through physical education
At Hayesbrook specialist Sports College in Kent, the BBALL FUN Programme is a key stage three cross-curricular resource that uses basketball in physical education lessons to teach the functional skills of literacy, numeracy and ICT. This can be applied across the range of invasion games. The flexible scheme of work can be easily moved into the curriculum for Year 7 and 8 and include pupils who have little or no prior experience of basketball to enjoy and learn from the lessons.

Each lesson has five teams of five or six pupils working as players on the court (physical education), coaches and statisticians (numeracy), commentators and journalists (literacy), television camera operators and sports photographers (ICT). The FUN Pack provides task cards for pupils and the lesson rotation plan for teachers to switch teams through the different subject areas for the next lesson. Teams of pupils rotate on a weekly basis and take on the roles identified above. Within the lesson, pupils take part as performers within a structured game either as players or officials. Other pupils act as scorers, timekeepers, coaches or match analysts recording the number of passes or shots. Using video and still cameras other pupils record the game and download the footage or visual images whilst another group provides recorded match commentary and match reports all of which can contribute to the production of a newsletter or added to the school’s website. The West Kent e-learning group has provided eight schools with the essential ICT equipment including camcorders, MP3 voice recorders and digital cameras to enable them to develop the lessons. The FUN resources are also available for use with Rugby and with new curriculum links for year eight 

Games consoles
Games consoles are being used in schools to encourage disaffected pupils in physical education lessons in order to increase fitness levels. Some schools are using the consoles to simulate actions of certain activities to improve pupils’ behaviour and teamwork skills through tennis, baseball, snowboarding and skiing for example. Whilst some may think that the use of virtual reality games is contradictory in raising activity levels and attainment there is anecdotal evidence to suggest that, with rigid structures in place using specific games, pupils can be physically active without releasing the console. In one case study project teachers identified pupils between the ages of fourteen and sixteen who had often missed physical education lessons. A games console was bought for each school, along with heart rate monitors to show how much physical activity the teenagers were getting from using the consoles. 

Nintendo Wii Fit
The Wii Fit is a video game that has been designed by Nintendo for the Wii console. The game focuses on exercise which involves an individual using a Wii balance board. The board is a wireless accessory and contains multiple pressure sensors used to measure an individual’s centre of balance. This can be applied to activity games such as skiing, for example. The ‘Wii Fit’ package includes a ‘Wii Fit’ game disk for the Nintendo Wii console containing fitness training related games and activities. The balance board measures a user’s mass and centre of balance. The software can then calculate the user’s body mass index when told of his or her height. The game consists of different sub-games and activitie – some of which are not available until being unlocked by building up credits in the ‘Fit Bank’, including yoga poses, strength training, aerobics, balance games and other exercises. Furthermore, Wii Fit allows its players to compare their fitness by using Wii Fit’s own channel on the menu. 

Dance mat systems
There a number of multi-player wireless dance mat systems where pupils can activate panels on a dance platform in sequence with four arrows on a screen and the beat of music. DanceMachine offer a twenty mat system for schools. It has been developed to improve fitness levels through hi-tech sound and visual equipment and is suitable for all key stages. This interactive range of equipment is designed to improve fitness through a large video screen and the latest hi-tech sound equipment. This system tests both mental and physical activity through the many games and music to choose from and offers unlimited hours of physical activity. Interactive fitness equipment offers many benefits to the growing concerns of pupil’s participation in physical activity. Amongst the many benefits to pupils is that they will burn off energy, boost their overall fitness, improve coordination and cardiovascular health. Dance steps are projected on to a wall or screen; users follow the steps displayed by arrows on their individual dance mat. At the end of song or session, users and instructors can see instant feedback on how well they performed, along with a leadership board for motivational competitiveness. Physical activity can therefore be more enjoyable and fitness and coordination is improved. Each dance mat is easily transported to different location by a storage cart that can hold up to sixteen dance mats. The iDANCE multi-player system offers up to thirty wireless dance platforms, simultaneous play and three levels of difficulty which can be seen at the same time and is ideal for mixed levels of ability. 

Pedometers
The FitLinxx ActiPed is a next generation pedometer that clips to a shoe and records the wearer’s walking, running or jumping as well as measures the distance travelled, calories burnt and total time of active minutes. This data can be stored and sent wirelessly and securely to an ActiPed account for the wearer to view their achievement and compare with their peer group 

Other innovative developments using ICT in physical education is the Nike Plus programme. This programme allows pupils to monitor their progress with regards to their levels of exercise in a similar way to other pedometers. This requires an iPod or Nike Plus sport band, sensor for shoes, sensor case to attach to shoe and a receiver for an iPod Nano. As pupils run, an iPod indicates their time, distance, pace and calories burned. And it gives you feedback at the halfway point and in the final lead-up to your goal. You can also see the details of your workout on your iPod. On selected workouts when using it with a Nano/iPod sporting legends such as Lance Armstrong and Venus Williams give periodic motivational help.

Pupil response systems
Interactive pupil response systems are designed to engage and motivate pupils whilst giving the teacher the tools to monitor and record pupil progress. They are sometimes referred to as classroom voting systems, utilising advanced radio frequency technology and integrating with curriculum software. Pupil response systems add increased interactivity into classrooms through interactive writing tablets or wireless slates which presents a cost effective alternative to interactive whiteboard technology. Pupil response systems are essentially a series of handsets that interact with additional software for Windows PowerPoint which allows pupils to interact with the teacher’s presentation. This could be in the form of a quiz or formal assessment. Each pupil has access to a handset and if required can remain anonymous throughout the activity, or it can relate to each pupil individually. The results from each question can be highlighted to the group, via a graph or table, and pupils can compete against one another with a marking system, or a time limit, that can be adopted by the teacher.

Archos
Archos is an MP4 mass storage unit that has the capability of accessing the web, transmitting video, still images and music through an external source such as a speaker system or interactive whiteboard. The main function within physical education lessons is its ability to record video footage. The player has a small camera attachment that can film any type of activity, such as a dance performance, and it can be instantly played back on the Archos’s 4-inch screen. The screen size allows for students to observe theirs or others’ technique and make comment, or watch the performance. During the playback mode there is also the opportunity to slow the action down to several variable speeds, as well as pause the footage. This is ideal when illustrating areas for improvement, or highlighting good technique and also incredibly visual for the pupils observing. Playback can instantly be transferred to a PC or laptop, and therefore be viewed on the ‘big screen’, or even edited to make into a video. It is a reliable back up for pupils’ written assignments and can make the course content far more interesting and challenging. At Seaford Head Community College, pupils have created videos of good technique during outdoor and adventurous activities whilst using the climbing wall using the Archos to capture the footage. They have then used the school’s ICT suite to edit their footage together to make a short film. The physical education department has also used the Archos equipment to film evidence of completion of BTEC National Diploma work with the Year 12 pupils. It has provided a reliable back up for the pupils’ written assignments and has made the course content far more interesting and challenging. 

Archos can save video footage which can be used for starter material at the beginning of a lesson. For example, footage taken from the previous lesson, or information from the internet, or digital television. Clips can be related to the lesson focus, or learning objectives. Information can be stored on the device that will relate to the lesson planned such as a good technique or performance. This could be observed at any stage throughout the lesson by pupils in order for them to enhance and compare their own work against the work of others. Music can be used at any stage and can play whilst the Archos is performing another feature. For example, it would be possible for the Archos to be plugged into speakers for a dance or gymnastics performance as well as film the performance itself. 

Wireless internet (wifi) is also a feature as pupils can access the web in wifi areas to aid their research within accredited courses at key stage four and beyond by searching for items related to the work being covered. This does require a licence from Archos and involves a fee. Filming is easy with the ‘Head camera’. Pupils can gain instant feedback on what they have performed and develop work as a result. They can use the slow motion tool on the device to illustrate an action or to evaluate their own and others performance. This information can then be stored on any computer system that has the software installed (this will take three minutes to install). Footage is stored via USB and takes moments to save minutes of work. This can then be used in various ways. For example, it can be added to Movie Maker and edited into a movie. It can also be added to presentations (PowerPoint). To view the footage on a larger scale it takes moments to plug the device in and illustrate the work on the interactive whiteboard. This works via USB again (similar to a memory stick) and can be watched and paused a number of times. Slow motion is not available at a larger scale as the footage is being played through the computer, rather than the Archos unit itself.

The use of iPods 
An iPod is a brand of portable media players designed and marketed by Apple Inc. The products includes the hard drive based iPod Classic, the touchscreen iPod Touch, the video-capable iPod Nano  and the compact iPod Shuffle. The iPhone can function as an iPod but is generally treated as a separate product. iPod Classic models store media on an internal hard drive, while all other models use flash memory to enable their smaller size. As with many other digital music players, iPods, excluding the iPod Touch, can also serve as external data storage devices. Storage capacity varies by model.

The iTunes software can be used to transfer music to the devices from computers using certain versions of Apple Macintosh and Microsoft Windows operating systems. The use of iTunes and its alternatives may also transfer photographs, videos, games, contact information, e-mail settings, Web bookmarks and calendars to iPod models supporting those features. 
There are a number of potential benefits of using gadgets such as iPods which can engage and motivate pupils through analysis of performance. Pupils can rip and upload videos to their own. A dictaphone can allow pupils to provide commentary to moving images. For teachers it allows practical forms of assessment to take place and provide immediate results and feedback. 
Clips can be stored in pupil files allowing for reduced marking and paperwork for both teachers and pupils. The iPod shuffle is a digital audio player that uses flash memory which can provide teachers with quick and easy access to music playlists for dance lessons and can be played through a docking station using speakers. Other applications include the iPhone which is an internet and multimedia enabled ‘Smartphone’ designed and marketed by Apple Inc. Functions include a camera phone, portable media player similar to a video iPod and full internet access including web browsing.

Podcasting
A podcast is a series of audio or video digital media files which are distributed over the internet by download, through web feeds, to portable media players and personal computers. A podcast is distinguished from most other digital media formats by its ability to be syndicated, subscribed to and downloaded automatically when new content is added. Like the term broadcast, podcast refers either to the series of content itself or to the method by which it is syndicated; the latter is also called podcasting. 

The virtual learning environment (VLE)
The virtual learning environment (VLE) has transformed the way in which pupils learn and teachers teach. The virtual learning environment is a global website that allows pupils to access their work and their curriculum from anywhere in the world. It is rights-protected and therefore only parents, students and staff will be able to log in. Pupils work can be set, collected and marked via the VLE, saving on a great deal of paperwork and collection and deadline dates. This, in turn, can empower pupils and inform their own learning. Pupils are able to make more decisions, as tasks will be completed at their own pace and potentially in their own time.
There are many ways in which physical education teachers can optimise pupil’s knowledge and understanding through the use of this technology, which has significant advantages. For example, pupils are able to join subjects (known as courses) and from there they will see the tasks, homework, quizzes and forums linked to the teacher, from home and school. As a teacher you are able to post work for your pupils that will be available around the clock. Your pupils will be able to submit work online and you can feedback to them from anywhere in the world. This allows teachers, parents and pupils to monitor their work and current attainment in physical education.


Video conferencing
In schools video conferencing can be used for formal teaching, using guest teachers, multi-school projects and community events. Once connected, pupils can see the other person on a TV screen and ask questions. The equipment required includes a TV monitor, camera, microphone, speaker and a compressed video system which can be transmitted through an Integrated Services Digital Network (ISDN). Video conferencing can provide pupils with the opportunity to learn in different ways, which might include a focus on a particular topic being covered in physical education at examination level. This could be arranged with another physical education department where teachers can offer particular expertise within an examination syllabus allowing for the sharing of information. This may be particularly useful for post-sixteen courses in physical education that have an international dimension and allow pupils to research a particular topic unique to one country. Equally, teachers could make use of video conferencing for cross-moderation of pupils’ practical and theoretical work in physical education in post-fourteen and post-sixteen accredited courses. This interactive approach to teaching can be highly motivating for pupils and improve their communication and presentation skills. In addition, memory retention can potentially be improved and a range of different learning styles can be catered for and can provide a much broader forum where learning can take place.
The use of YouTube within schools.
YouTube is a video-sharing website where users can upload, view and share video clips. It uses Adobe flash video technology to display a wide variety of user-generated video content, including movie clips, television clips and music videos, as well as amateur content such as video blogging and short original videos. Most of the content on YouTube has been uploaded by individuals, although media corporations including the BBC offer some of their material via the site. The wide range of topics covered by YouTube has turned video sharing into one of the most important parts of internet culture. YouTube is fast becoming an effective medium for gaining and presenting images in schools. 
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Unit-II
Introduction


Microsoft word: Microsoft Word is the word processing component of the Microsoft Office Suite. It is used primarily to enter, edit, format, save, retrieve and print documents.

Starting Microsoft Word

To load Microsoft Word:

1. Click on the Start menu in the bottom left corner of the screen 

2. Choose All Programs then Microsoft Office (from the sub-menu which appears) 

3. Finally click on Microsoft Office Word 2007 

Tip: You'll probably be using Word quite frequently in the future, so it's worth putting it as an icon on the Desktop. To do this, repeat the above steps, but at the last step, right click (ie press the right mouse button) and choose Send To followed by Desktop (create shortcut). To load Word in future, simply double click on the Desktop icon.

[bookmark: page3]The window shown below will open, ready for you to begin typing.
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In the top left-hand corner is the [Office] button which can be used to open and print your document. To the right of this is the Quick Access Toolbar which contains icons to a few commands, eg save and undo, and to which you can add further buttons. Below this is the Ribbon, with tabs along the top and command buttons on each tab. These can be used to give instructions to Word.

Scroll bars are provided on the right (and bottom) to let you move up and down (or sideways across) your work. At the very bottom of the window, there is information about where you are in your document on the Status Bar - here you are on Page 1. The information that is shown on the Status Bar is a word count and the language you’re working in. On the right-hand side of the Status Bar are icons to change the view of the page, and to zoom in or out, ie make the text on the screen bigger or smaller.


Writing Your Document

You next need to decide how you want the rest of your text to appear. It's easiest to set this up before you start typing - the settings will then be carried forward from one paragraph to the next.

Changing Fonts

Font - [image: ]

The starting font for a new document in Word 2007 is usually set to Calibri (Body). You might want to use a different style of lettering (font or typeface) to personalise your work. Several fonts are available in Word. If you want to change the current font:

1. Click on the list arrow attached to the [Font] button on the Home tab 

2. Click on the font you require, eg Times New Roman – you can either scroll down the list to find the font you want, or type in the name of the font to pick it up more quickly 

Tip: It's best to stick to true-type fonts (those labelled TT) to maintain your document's portability.

Some fonts (eg Symbol and Wingdings) produce non-Roman letters or iconic symbols. Courier New gives a typewriter font. Sans-serif fonts, such as Ariel, give clear headings.


[bookmark: page4]Changing Font Size

Font Size - [image: ]

Generally a point size of 10, 11 or 12 is used for the body of the text while point sizes of 13 to 16 are used for headings. The current size (11) is shown in the font size box. To alter this:

1. Click on the list arrow attached to the [Font Size] button on the Home tab 

2. Click on the size you require - for example, 12 

Tip: You can also type the number directly into the font size box (press <Enter> to set it). This allows you to select a font size not in the list, for example 13 or a bigger number if you want very large characters.

Entering Your Text

1. Type in a few words, pressing the <spacebar> once after each word to separate them (the spacebar is the long key along the bottom of the keyboard) 

If you are not very fast at typing just type some imaginary words, pressing keys at random, but remember to include spaces between your words. Remember that if you want to improve your typing, there is an Accu-Type training tutorial on the IT Services PCs (you can also buy a copy for a personal computer).

2. Continue typing across the screen - the words will automatically spill onto a new line when you reach the right-hand side (this is known as wraparound) 

3. Continue typing until you have at least three lines of words then press <Enter> to mark the end of the paragraph (this is the upside-down L-shaped key on the right of the main keyboard – it is also located on the far right of the keyboard, in the numeric keypad, with the word Enter written on it) 

IMPORTANT: When using a word processor, do NOT press the <Enter> key at the end of each line. If you need your work double spaced (each line followed by a blank line) then you simply change the paragraph's line spacing - this is covered later on. Press <Enter> only when you want to start a new paragraph.

A jagged red (or occasionally green) line may appear beneath your text. Don't worry about this - Word is telling you that what you typed is not recognised (the words are not in the dictionary) or that the grammar may be incorrect. You learn more about this later.

Tip: Never press the <spacebar> or <Enter> key more than twice in succession. In particular, do not use spaces to centre a heading or line up words in columns, or to add extra blank lines to force a heading onto a new page. There are special key presses that do this for you (tabs and hard page breaks) that are covered in our  Microsoft Word Intermediate Guide.

4.  Practice typing a couple of extra paragraphs, pressing <Enter> at the end of each

Correcting Mistakes

Don't worry if you go wrong, as it is very easy to correct your work. The <Backspace> key (immediately above <Enter> in the main section of the keyboard) can be used to delete the last character(s) typed.

1.  Press <Backspace> a few times and note what happens

You should have noticed a flashing vertical bar on the screen at the end of your work. This marks the insertion point. Anything that you type will always appear at the insertion point. You can move the insertion point around your work by using the arrow keys to the right of the main keyboard. You can also change its position by moving the mouse pointer on the screen and clicking where you want the insertion point to be.

2. Press the <arrow> keys to move the insertion point around - note that you can hold down a key to move more rapidly 

3. Move the mouse to position the pointer in the middle of a paragraph and click on the mouse button - the insertion point should have moved to where you clicked 

4. [bookmark: page5]Type in some more words - watch how the text which follows moves sideways to make room for the new words 

As the text moves, the following lines of the paragraph are redrawn automatically. Within a paragraph, the <Backspace> key works as before but you can also remove characters forwards:

5.  Press the <Delete> key (immediately to the right of <Enter>) a few times and note what happens

Here you are only practicing on text you do not need to keep, but you may accidentally delete words that you needed. Do not panic! If you ever make a mistake when using Word then you can undo your error by using the [Undo] button.

Undo - [image: ]

This can be found on the Quick Access Bar in the top left-hand corner. The undo button can be used more than once, to undo a series of actions, one at a time.

6.  Click on the [Undo] button several times to see its effect

Note: There's also a [Redo] button (to the right of [Undo]) if you accidentally undo too much!

Tip: Word lets you use control key combinations to issue commands from the keyboard. The combination <Ctrl z>(hold down <Ctrl> and press <z>) can be used to undo something. <Ctrl y> can be used for redo.


Aligning Text on the Page

Align Left - [image: ]  Centre - [image: ]  Align Right - [image: ]  Justify - [image: ]

With Microsoft Word, it's easy to change the appearance of your work. Changes to the way a paragraph is laid out can be made by first moving the insertion point into that paragraph (anywhere will do). You can then decide how you want your paragraph to look.

1.  Move the insertion point into the paragraph you want to change

When typing a document you normally want text to align on the left-hand side of the page. Some people prefer text to be fully justified - this is where text aligns both left and right. You can also align text to the right (eg for an address) or to the centre (eg for a title or heading). You can use the buttons shown above (they are on the Home tab in the Paragraph group) to control how text is aligned on the page.

2. Try out all four justification buttons (or use <Ctrl l>, <Ctrl e>, <Ctrl r> and <Ctrl j>) - note that only the current paragraph is affected; each paragraph has its own justification setting 

Tip: If you like justified text, consider turning on hyphenation. This automatically splits a long word at the end of a line in two, improving the layout considerably. To turn this on, click the Page Layout tab, then the [Hyphenation] button in the Page Setup group and choose Automatic.

Altering Line Spacing

Line Spacing - [image: ]

Sometimes you might be asked to double space your work (or use some other spacing). You might even choose to have a quotation (for example) one-and-a-half spaced, with the rest of your text double spaced. You should still be in the paragraph where you tested the different justification settings.

1. Click on the list arrow attached to the [Line Spacing] button in the Paragraph group 

2. Select 2.0 for double spacing 

Tip: You can also use <Ctrl 2> (hold down <Ctrl> and press <2>) for double, <Ctrl 1> for single and <Ctrl 5> for one-and-a-half spacing. <Ctrl 0> adds a blank line before a paragraph.

[bookmark: page6]Changing the Look of Your Text

Bold - [image: ]  Italic - [image: ]  Underline - [image: ]

As well as changing the font and font size, you can make some other fairly simple formatting changes that change the look of your text. Here try out the bold, italic and underline buttons which are in the Font group on the Home tab.

1. Move to the bottom of your current document. A quick way to do this is to use the control key combination <Ctrl End> (the <End> key is located in the block of six keys to the right of the main keyboard letters). Press <Enter> until you’re on a new line 

2. Click on the [Bold] button and type in some new words. You will find that these words appear in a blacker colour. To turn off bold, click on the [Bold] button again 

3. Try out the [Italic] and [Underline] buttons as in the above step 

Note that you can have your text with more than one of these options set on - bold italic or underlined italic, for example. For emphasis, it is usually best to stick to bold. Italic is often used in the title of a paper or journal in bibliographies or references, and underline can be used for a heading or subheading.

Tip: The control key combinations to get bold, italic or underline are respectively, <Ctrl b> for bold, <Ctrl i> for italic and <Ctrl u> for underline.


Saving Your Work

You should save your work regularly - ideally every 10 minutes so that you don't lose what you have typed should the computer stop working. Word does have an autosave facility which should guard against loss of work; however this is not a proper save and should not be relied on.

1. Click on the [Office] button in the top left-hand corner and then choose Save (or use the [Save] button on the Quick Access Toolbar ) 
[image: ]







For a new document, a Save As dialog box similar to that below will appear:
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2. Type a name for your work (eg my first document) - there's no need to clear the File name: box first; whatever you type will replace what's there already 


[bookmark: page7]Note: you should mainly use letters and numbers for your file names (spaces, hyphens and underscores are also permitted); DO NOT use any other punctuation marks as they can cause problems.

Your work will be saved to My Documents, which has been set up to be on drive N: on the computers on campus. This is an area on the network where you can save your own work, known as your home directory. No one else has access to your home directory; you connect to it whenever you logon to an IT Services computer. Backup copies of the files in your home directory are made hourly, so you should never lose any of your work.

Though the [Save] button shows a picture of a floppy disk, it is NOT a good idea to work directly from floppy. They can easily be damaged (or lost) and work can be corrupted if they become full. We recommend you only use floppy disks to move your files from one computer to another (this also applies to more modern media such as memory sticks and CDs).

Note: By using Save As rather than Save, you can save your work as a Word 97-2003 document so that it is compatible with earlier versions of Word. This will make it easier for anyone who has an older version of Word to open the document. However, any features that are only available in Word 2007 may not be saved (a warning will come up to say which features these are).

3.  Press <Enter> or click on [Save]

Once you have given your document a name, this will appear (instead of the original name, eg Document1) at the top of the Word window. Note that the extension .docx (or .doc for Word 2003 documents) is added automatically.

Tip: It is a good idea to save your work regularly (eg every 10 minutes or so). The easiest way to do this is to press <Ctrl s> periodically.


Working with Selected Text

Selecting text is very important as it identifies which section of text you want Word to modify. It can be used to change how some text looks, to move or copy text within a document, between documents or between different applications (eg Word and PowerPoint), and to delete or replace text.

A simple way to select part of your text is by dragging through it as follows:

1. Move the mouse so that the pointer on the screen is at the start of the text that you want to change 

2. Hold down the mouse button, and keep it held down 

3. Drag the mouse sideways to move the pointer to the end of the text that you would like to change – the selected text now has a blue background 

4. When you are happy with your selection, release the mouse button 

You may have noticed that a set of option buttons have appeared just to the right of your selected text like in the example below:
[image: ]





These different buttons immediately allow you to change the look of the selected text, eg make it bold, alter the font or size, turn it into a list etc.

If you accidentally go wrong and select the wrong text, click the mouse once (this will release the selection) and try again.

Tip: Minor adjustments to a selected area can be made by holding down the <Shift> key and pressing the <left arrow> or <right arrow> key. This method can also be used instead of dragging through the text. Rows of text can be selected using the <down arrow> or <up arrow> keys.


[bookmark: page8]Tip: If ever you want to replace some words with something different, simply select the words to be replaced and then type the new ones (the selected text automatically disappears). You can also delete a section of text by first selecting it and then pressing the <Backspace> or <Delete> key.


Selecting the Text

Selecting can be done in several different ways, depending on how much text is involved. Any selected text can be de-selected by clicking on the mouse button once.

Try out the following:

· A single word - point to it using the mouse then double click on the mouse button - your selected word should be highlighted. Click once on the mouse to de-select it 

· A single line - position the mouse pointer in the left-hand margin (where its shape changes to an arrow pointing inwards) and click once 

· A whole paragraph - either double click in the left margin or click three times within the text 

· The whole document - either click three times in the left margin or press <Ctrl a> 

· A sentence - hold down <Ctrl> and click anywhere within the sentence 

· A short piece of text - drag through the text to be selected 

· A long piece of text - click at the start of the text to be selected then move down, using the scroll bars, and hold down <Shift> as you click at the end of the selection 

· To modify an existing selection - hold down <Shift> and use the arrow keys 

Cut, Copy and Paste

Cut - [image: ]  Copy - [image: ]  Paste - [image: ]  Format Painter - [image: ]

The above buttons are visible on the far left of the Home tab in the Clipboard group.

Moving text around a document is done by:

i. Selecting it 

ii. Cutting or copying it from its present position 

iii. Pasting it back to its new one 

You can copy information within the same document, from one document to another, or from one program to another (for example, text on a web page can be copied into your Word document).

1. Move to the top of your document (pressing <Ctrl Home> takes you straight there) and select the first paragraph of text (double click at the left or three times within the paragraph) 

2. Click on the [Cut] button and the paragraph will disappear - do not be alarmed, it has not been lost, but has been copied onto the clipboard 

3. Move the insertion point down to the end of your text (pressing <Ctrl End> moves you straight there) 

– add a new line if necessary by pressing <Enter> 

4. Click on the [Paste] button - your original paragraph will be pasted into its new position 

Tip: You can also use <Ctrl x> to issue a cut command - <Ctrl c> gives copy; <Ctrl v> paste.

You’ll find that a paste options icon [image: ] appears next to the pasted text – clicking on this will give further options to how you want the pasted text to look (leave it as Keep Source Formatting - it won’t disappear until you do something else like adding some more text).


[bookmark: page9]Note: You can also use right click on selected text and choose Cut or Copy from the shortcut menu, then move to the new position and finally right click there and choose Paste from the shortcut menu.

Note also the [Format Painter] button. This is used to copy the format (font and/or paragraph settings) from one piece of text to another:

5. Select the text (or paragraph) whose format you wish to copy - try the text you made bold earlier 

6. Click on the [Format Painter] button (the pointer becomes a paintbrush) 

7. Drag through another piece of text - release the mouse button and it too becomes bold 

This can be especially useful in the case where you notice that a paragraph looks different from the rest of the paragraphs on that page, maybe because it is in a different font. You can use the [Format Painter] button to quickly correct this problem.

Making Multiple Copies and the Clipboard

When making multiple copies of text, you normally Copy rather than Cut it to the clipboard:

1. Select some text (a few words will do) and click on the [Copy] button (or press <Ctrl c> or right click and choose Copy) 

2. Your original text will remain where it is, but a copy of it has been placed on the clipboard 

3. Move the insertion point to where you want to paste the text 

4. Click on the [Paste] button (or press <Ctrl v> or right click and choose Paste) 

5. Repeat the above step and a second copy of the text will appear 

The clipboard, which is normally hidden, will only store the last item that you cut or copied but, after displaying it, up to 24 items can be stored on it. To display the clipboard:

6. Click on the Clipboard group arrow  [image: ] just below the [Format Painter] button – this will open the 

Office Clipboard in a Task Pane on the left 

7. Select another part of your text and [Copy] it - watch it appear on the clipboard 

8. Move the insertion point then click on the new clipboard entry to paste it into your text 

9. Repeat the above step but click on the original clipboard entry 

You won't need to paste any of the text again, so it's a good idea to empty the clipboard:

10. Click on the [Clear All] button in the Clipboard pane 

11. Close the Task Pane by clicking on its [Close] button (the little x in the top right corner) 

Drag and Drop

If you wish to move text a short way then you can use the drag and drop technique:

1. Select some text - a few words is sufficient 

2. Move the mouse pointer into the highlighted area then hold down the mouse button (the pointer becomes an arrow with a box attached and in the left-hand corner of the Status Bar at the bottom of your Word window it says Move to where?) 

3. Keeping the mouse button held down, drag the text to a new place in your document (as you move the cursor a faint dotted line appears - this is where the selected text will be dropped) 

4. Release the button - the text will be moved to its new position 

5. Practice moving selected text to other positions 

Tip: The key combination <Alt Shift> with the <up/down arrow >key moves a selected paragraph up or down the page one paragraph at a time.



[bookmark: page10]Further Formatting

Most of your text will be with the same layout of paragraphs. However, sometimes you will need to change the layout for other special sections (eg for a list).

Bulleted and Numbered Lists

Bullets - [image: ]  Numbering - [image: ]

It is often useful to create lists using either bullets or numbers. The [Bullets] button gives you a bulleted list:

1. Move to the end of the text (press <Ctrl End>) and make sure you are on a blank line 

2. Click on the [Bullets] button (on the Home tab in the Paragraph group) – a bullet point should appear 

3. Type a couple of words against each bullet point, pressing <Enter> once after each one 

4. Press <Enter> twice at the end to turn the bullets off 

Numbers are applied in a similar fashion using the [Numbering] button:

5. Click on the [Numbering] button - a number 1. appears 

6. Type in two short paragraphs (one a couple of lines long), pressing <Enter> once after each one 

Note that each paragraph is numbered and that the first line of text is indented slightly to allow for the number. The second line of text is also indented, to line up with the words of the first line.

7. Move to the end of the paragraph numbered 1 and press <Enter> - a new number will be inserted in the correct sequence with later lines re-numbered 

8. Press <Tab> (the button to the left of the letter Q) and the numbering changes to a and is indented further – type a few characters 

9. Press <Enter> (the letter b appears) then <Shift Tab> (the letter changes to the number 2) 

10. Press <Delete> and the extra line will disappear 

11. Move to the last line in the numbered list (which should be empty) and press <Enter> - this should turn numbering off 

Tip: Sometimes you might want more than one paragraph under a bulleted or numbered point. To achieve this, hold down <Shift> as you press <Enter> to end a paragraph (it’s best to have the text left-aligned – justified text doesn’t look good).


Correcting Spelling and Grammar

Spelling and Grammar - [image: ]

Word checks the spelling and grammar as you type. A red squiggly line under a word denotes that Word thinks it has been spelt incorrectly; if the line is green then the grammar may be incorrect. You can check the whole or part of the text for mistakes using the [Spelling and Grammar] button.

1. Press <Ctrl End> to move to the end of your text then <Enter> for a new line 

2. Type the following misspelt text: 

howe mamy speling andother erors is there on thsi sentance? There was 10.

Note that as you type the words, Word automatically corrects certain mistakes:

· it capitalises the first word in a sentence (Howe) 

· it corrects certain misspellings (eg erors to errors, thsi to this and sentance to sentence) 
3. [bookmark: page11]Select the line of misspelt text (eg click 3 times on it) - Word can spell-check just a selected area 

4. Move to the Review tab and click on the [Spelling and Grammar] button on the left of the Ribbon 
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5. Choose the correct spelling of many in the Suggestions: box – press <Enter> for [Change] 

6. Continue in the same manner with the other corrections 

7. Always check the correction is what you want - with andother choose and other 

If Word gives you no suggestions (or doesn't show the correct one in the list) you can edit the text in the Not in Dictionary: box. Also if a spelling is correct but not in the dictionary, you can either choose to [Ignore] a suggested correction or [Add] the word to your own dictionary. Choose [Ignore All] if you don't want to be asked about the same spelling again (similarly [Change All] will change all occurrences of a misspelt word). You can also [Close] or [Cancel] the check at any time.

Once the spelling check is complete, the grammar checker is run. This isn't foolproof, but it does pick up some common grammatical mistakes. At the end of the grammar check:

8. Click on [No] - you don't want the rest of the document checked 

9. Press <End> to deselect the highlighted text then <Enter> to start a new paragraph 

Tip: If you just have one word that is misspelt (or a phrase with bad grammar), move the mouse pointer over the error and click on the right mouse button. A list of likely correct spellings appears. If the spelling you want isn't in the list, choose Spelling... (or Grammar...) to start the checker.

Note that you will still need to proof read your work to pick up, for example, correctly spelt words used in the wrong context. Here, Howe was not corrected because it was recognised as a surname - it would have been picked up had it not been capitalised (by Word itself!). Similarly, on needs manual correction to in. Also, though was was corrected to were in the second sentence, the grammar checker failed to notice that is in the first sentence had a plural subject and should be are.


Closing a Document

Although you can have more than one document open in Word, if you have finished working on a file, it is a good idea to close it. Before closing it, remember to save it:

1.  The quickest way is to press <Ctrl s>

As you’ve already saved your document previously, this time it won’t come up with any Save As window, but will automatically save the latest version of your document overwriting the previous version. If you did want to save your document under a different name, into a different place or in a different format then you should choose one of the options under Save As.

[bookmark: page12]To close the current document without exiting from Word:

2.  Click on the [Office] button in the top left-hand corner and then choose [Close]

Tip: You can close a document from the keyboard using the key combination <Ctrl F4>.


Opening an Existing Document

You may want to do some further work on an existing document. In this next exercise you will be opening the file you have just closed.


1.  Click on the [Office] button and choose Open

Note the list of Recent Documents on the right-hand side – from here you can open up your latest documents and can pin documents permanently to the list. The [Open] button on the Quick Access Toolbar (or the key combination <Ctrl o>) can be used to open a file but you then don’t see the list of Recent Documents.
[image: ]


You will see a dialog box similar to the following, showing any folders and Word files in My Documents:

2.  Click on the name of your file you want to work on, eg my first document.docx
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3.  Press <Enter> or click on [Open]

Use the <Page Down> key (above the arrow keys) to move down your document or <Ctrl End> to go to the end of your document.

Note: You can have more than one document open at a time in Microsoft Word. This allows you to copy text from one document to another. You can move between documents by clicking on the View tab and then the [Switch Windows] button (or the buttons on the Taskbar, normally located at the bottom of your screen).



[bookmark: page13]Starting a New Document

To start a new empty document at any time from within Word:

1. Click on the [Office] button and choose New 

2. A New Document window will open – the Blank document icon will already be selected so just click on [Create] 
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If you use the [New] button on the Quick Access Toolbar (or the key combination <Ctrl n>) then the new document appears immediately

Tip: If ever you are working on a document and all the text disappears, check the document name at the top of the screen. You may have accidentally pressed <Ctrl n> to create a new document! If this is the case, press <Ctrl F4> to Close the new, unwanted, document.


Printing


To print your document:

1. Click on the [Office] button and choose Print button (or click on the [Print] button on the Quick Access Toolbar or use the keyboard combination <Ctrl p>) – the following window appears: 
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2. Check that Name: is set to \\viprn1\ITS-A4BW (for black and white output - you'll need to change this to \\viprn1\ITS-A4Colour using the list arrow provided if you want colour) 

3. Set the required Page range and Number of copies: 

4. The final step would normally be to click on [OK] but here, click on [Cancel] 

[bookmark: page14]It's a good idea to preview your work to check it fits neatly on the page before you print it. To do this: 5. Click on the [Office] button then move the mouse cursor over Print – a sub-menu appears:
[image: ]














6. From the further options that appear, choose Print Preview 

7. Click on [Close print Preview] on the far right of the new Print Preview tab to return to normal typing 

Tip: It’s a good idea to add the [Print Preview] button to your Quick Access Toolbar. To do this, simply click on the down arrow on the right of the toolbar and turn Print Preview on. You may wish to add some of the other buttons. Incidentally, the keyboard combination to turn on/off Print Preview is <Ctrl Alt i>!




Leaving Microsoft Word

When you have finished typing and want to exit Word:

1. Make sure you’ve saved the latest version of your document (press <Ctrl s>) 

2. Click on the [Office] button then on the [Exit Word] button (bottom right-hand corner) or you can click on the [x] in the top right-hand corner of the Word window 

Tip: The keyboard combinations <Ctrl w> and <Alt F4> can also be used to close Word.


Logging Out

If you have completely finished using the computer:

1. Click on the [Start] button (bottom left-hand corner of screen) 

2. Choose Log Off 

3. Press <Enter> again (or click on [Log Off]) to confirm this 

Tip: A quick way to log off is to press the <Windows> key (between <Ctrl> and <Alt>) then the letter <l> for Logout followed by <Enter>.












UNIT-III (MS-EXCEL)
Introduction

Spreadsheets were originally developed for book keeping; however, they are also used for scientific calculations, data manipulation and for producing graphs. Excel includes some statistical functions, but for serious research work a specialised package such as SAS or SPSS should be used. Excel can also sort and select data subsets. For storing large amounts of data or more complex tasks, Access should be used. These notes cover the fundamental usage of Excel but also include many hints and tips.


Starting Excel

To start up the program:

1. Open the Windows Start menu

2. Choose All Programs then Microsoft Office followed by Microsoft Office Excel 2007

Tip: To create a shortcut to this software on the Desktop, right click on Microsoft Office Excel 2007 then choose Send To followed by Desktop (create shortcut). You’ll then be able to load Excel using the icon on the Desktop.

The Excel Screen

You will then be presented with an empty worksheet, as below, ready to enter your data:
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In the top left corner of the screen, the Office Button appears. Use this to Open or Print your files. To the right of this is the Quick Access Toolbar, which only has three buttons on it by default – Save, Undo and Redo. To add extra buttons, click on the down arrow on the right and choose Customize Quick Access Toolbar.

Moving right, Excel has given your work a name, Book1, which can comprise a set of related data and chart sheets. This name will change when you save your work in a file, at which time you will be asked to supply a real name. On the far right are the usual Minimize, Maximize and Close buttons.

The next section down the screen is called the Ribbon. This replaces the menu and toolbar system in previous versions of Excel. All the commands now appear as buttons (pictures) on this Ribbon, which has a series of tabs under which different commands are grouped. When you point to a button, a tool-tip appears, telling you what that button does.

Below the Ribbon is the command line. The area on the left (showing the characters A1) is the Name Box. To its right is the Formula Bar, which shows you what information is stored in a cell.

The main body of the screen contains the worksheet. You are currently using Sheet1 of Book1, as denoted by the sheet tab at the bottom. The worksheet has numbers down the side, denoting rows, and letters across the top denoting columns. Each intersection of a row and column is known as a cell and has a unique name. The cell in the top left corner is A1 (the intersection of column A and row 1) and is currently the active cell. This is denoted by a darker border, with its identity shown in the Name Box, while the column letter and row number are shown with an orange-brown background. Any information you type is stored in the active cell.

Down the right of the screen is the scroll bar, which is used for moving up and down your work. A horizontal scroll bar, for moving left and right, appears to the right of the sheet tabs. The mouse cursor should also be visible. This can have several different shapes, some of which you will be meeting later in the course. Within the cells it appears as an outlined cross.

Moving Around the Worksheet

Various keys or key combinations can be used to move the active cell around the worksheet. These include <Enter>, <Tab>, <Home> and the <arrow> keys (take care that <Scroll Lock> is not turned on as this affects the arrow keys). You can also move directly to a cell using the mouse:

1. Using the mouse, point to any cell other than A1

2. Click on the left mouse button to make this the active cell - note that the name of the cell in the Name Box has changed, as have the orange-brown row/column indicators

3. Move the active cell around the screen - try pressing the <arrow> keys, <Tab> (and <Shift Tab>) and <Enter> (and <Shift Enter>), noting the names of the cells in the Name Box

4. End by making A1 the active cell

Tip: Pressing <Ctrl Home> moves the active cell to cell A1. To move to the left edge of a block of data, hold down <Ctrl> and press an <arrow> key in the direction you wish to move. <Ctrl Enter> keeps the current cell the active cell – useful when entering data or editing a formula.


Saving your Work
[image: ]
Save:

It is important to save your work frequently - you never know when the computer might fail!

1.  Click on [Save] on the Quick Access Toolbar or use Save from the [Office] button

Up until now your work has been known as Book1; you are now asked to give it a proper name.
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J.Rajesh
Guest Faculty in U.C.P.E.S.S
2.  Type  test into the File name: box

Note that the default drive is set to My Documents (on drive N: - your home directory on IT Services PCs). Avoid working directly from/to floppy disks or a USB memory stick; always copy your files to My Documents, work on them there and then copy back to the floppy/stick, if required.

3.  Press <Enter> or click on [Save] to carry out the save

Note that once the file has been saved, the new name (test.xlsx) appears at the top of the screen.

Tip: Press <Ctrl s> every so often to save your file as you are working on it, thereby insuring you don't lose any changes you have made. <Ctrl s> is a shortcut key for the Save command.

Data Entry
[image: ]
Undo:

Information can be entered into the active cell, either in the form of raw data or calculations. Excel recognises various sorts of data - text, numbers, dates and times - which can then be used in formulae. Before you begin typing, make sure you are at the top left corner, in cell A1 (when following this course it is vital that you use the same cells as in the document).

1.  In A1, type the word  Income then press <right arrow> to move to B1

Income is recognised as text and is stored as such in A1. By default, text is shown on the left of a cell. Pressing <right arrow> completes the data entry and moves the active cell ready for the next item of data. If you need to correct a typing error, click on [Undo] on the Quick Access Toolbar or simply move back to the cell in question and retype the information.

2.  In B1, enter  22000 then press <down arrow> to move down to B2

22000 is stored as an ordinary number - on which the spreadsheet can perform calculations. By default, numbers appear on the right of a cell.

3. Move back to A2 (<left arrow>) and type  Costs then move to B2 (<right arrow>)

4. In B2, type  15000 then move to A3 (<down arrow> then <left arrow>)

5. In A3, type  Profit then move to B3 (<right arrow>)

In cell B3 you are going to store a formula to subtract costs from income. Note that formulas in Excel start with an equals (=) sign. As you type in a formula, any cell references are colour-coded to help you verify the correct cells are being used.

6.  In B3, type  =B1-B2 (or  =b1-b2 - case doesn't matter) and press <Enter>

Tip: When entering a formula into a cell you can pick up the cell references by clicking on the cells required with the mouse. Here in B3, for example, you would type = then click on B1 then type - before clicking on B2 and pressing <Enter>. This is particularly useful when picking up cell references from other sheets.

You are now presented with the result of the calculation rather than the formula itself, namely 7000. Note, however, that though Excel displays the answer, it is the formula which is stored in the cell. Spreadsheets are designed to recalculate as they go along, so see what happens when you change one of the original numbers.

4. Move up to B1 (press <up arrow>) and type  25000

5. Watch as you press <Enter> and note that the Profit (in B3) is recalculated as 10000

The formula  =B1-B2 knows that B1 has changed and the display in B3 adjusts accordingly.

Next extend the example to bring tax into the calculations.

9.  Change the text in A3 - move to the cell and enter  Profit Before Tax instead

On pressing <Enter> you will find the text is truncated (letters on the right are missing). Don't worry about this, the column will be widened later to show all the letters.
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10. In cell A4, type  Tax then move to B4 (press <right arrow>)

Assume that tax is levied at 30% of Profit Before Tax; enter the following formula for this cell:

11. In B4, type  =B3*30% (don't forget the leading = sign)

Note that Excel, in common with other computer software, uses an asterisk (*) for multiplication and a slash (/) for division. Use the numeric keypad for convenient access to these characters (if you want to use the numbers too, turn <Num Lock> on).

12. Press <Enter> and the tax figure (3000) will be worked out for you

13. Work out a label and a formula to put in cells A5 and B5 to show the Profit After Tax, assuming that this is Profit Before Tax minus Tax

Tip: As you begin to type the word Profit in A5, Excel picks up Profit Before Tax from the list of entries above. This is very useful when you are typing the same information again and again – eg Travel, Accommodation,

Food … on an expenses sheet. You don’t need this information this time, but you could edit it (by double clicking on the word Before on the Formula Bar and typing After instead).

Note how the words in A5 initially appear in full (they are only truncated when B5 is filled). If you have got the formula right (follow the links or look at the Appendix to check your answers), the screen should look like this (don't be tempted to cheat by typing in the value of 7000):
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Try altering the Income or Costs figures in B1 or B2 and notice how the Profit Before Tax, Tax and Profit After Tax figures are updated automatically. Use the [Undo] button (or retype the data) to reset the values to 25000 and 15000 respectively.

Naming a Cell

Sometimes it is useful to reference a cell by name rather than by column and row. For example, the tax rate (of 30%) could be held in a cell named taxrate and then referred to as such in any formulae.

1. Move down to cell A10 (ie well away from the rest of your work)

2. Click on the active cell name (A10) in the Name Box (just above the heading to column A) - the name will be highlighted

3. Type in the new name of  taxrate (spaces aren’t valid) then press <Enter>

4. Now, in cell A10, type in  30% and press <Enter>

5. Finally, amend the formula in cell B4 to read  =B3*taxrate then press <Enter>

Tip: It's easier to edit a formula rather than retype it in the cell. Click at the end of the Formula Bar then use <Backspace> to delete the 30%. Type in taxrate then press <Enter>. Note also that function key <F2> puts you in edit mode in the cell, with the typing position at the end of the contents. Use the arrow keys to move the typing position along the formula and press <Enter> or <Tab> to finish editing.

Examining the Cell Contents
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Often you want to view a formula rather than its result. You can examine an individual formula by making its cell the active cell. Move to cell B5 and you will see =B3-B4 showing in the Formula Bar. This means that the content of the cell B5 is the formula B3-B4 and not 7000, as displayed.

Move the active cell around and see what has been stored in each cell. Take this opportunity to make sure you understand what is happening.

Note: You can display all the formulae (rather than the results) by pressing <Ctrl `> (the key in the top left corner of the keyboard, above <Tab>). Press it again to return to normal.


Commands

Sometimes it is necessary to issue a command to tell the program to do something to the worksheet, such as altering its layout or saving it. The commands are found on the Ribbon. This has several tabs, covering different aspects of use. Most of the commands in this course are on the Home tab.

Some commands are also available by clicking the right button on the mouse or through <Ctrl> key combinations, as shown by the tool tips which appear when you select a button on the Ribbon.

Changing Column Width
[image: ]



Before proceeding further, change the layout so there is enough room to fit the whole of Profit After Tax into its column.

4. Move the mouse pointer onto the line between the letter A at the top of column A and B at the top of column B - the cursor changes becomes a double-headed arrow, as shown above

5. Hold down the mouse button and drag the column divider to the right - note that the current width is displayed as you move the divider (set the width to about 20.0 - 145 pixels)

6. Release the mouse button and the column is resized

Getting the column width right using this method can be very time consuming. To fit the column exactly to the data:

4. Move the mouse pointer to the dividing line between the column headings as before

5. Double click on the mouse button

Note: Column width can also be set via the [Format] button under Cells on the Home tab of the Ribbon. Here, Column Width… lets you type in a fixed width while AutoFit Column Width is equivalent to double-clicking on the column border.

If cells contain numeric data and the column width becomes too narrow to display the numbers properly then Excel displays ####### instead. The first time you see this you will probably think an error has occurred, so it's useful to demonstrate it here:

6. Move the mouse pointer to the dividing line separating the column B and C headings

7. Hold down the mouse button and drag the divider to the left - set the width to less than 5.0

8. Release the mouse button and ####### should appear in some or all the cells

9. Use the [Undo] button to restore the column to its original width

Changing the Format

Accounting:  [image: ]  Percent:   [image: ]  Comma:  [image: ]  Increase Decimal:  [image: ]  Decrease Decimal:
[image: ]
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The way data in a cell is displayed can be set using a format. For example, a date could be shown as 25-12-09 or 25 Dec 09 or 25th December 2009 or in various other similar ways. The basic information held in the cell is identical, however; it's up to you how you want it displayed. In this next exercise, you will add a currency format to your data.

1.  Change the Income figure in B1 to  24444 then press <Enter>

The resulting Tax and Profit After Tax figures are now displayed with a single decimal place. This looks a bit untidy as the other figures have no decimal places. It would be neater if all the numbers were shown as a currency, either with two decimal places (pounds and pence) or as whole numbers (pounds only). To do this, you first have to select the cells (here, format the whole column).

3. Click once on the letter B at the top of the column - the column should be highlighted (except for cell

B1)

Five commonly-used formats are provided in the Number group on the Home tab of the Ribbon.

3.  Click on the first formatting button for an [Accounting] style

What was 24444 should now be shown as £24,444.00. If ####### is displayed, widen the column.

4.  To remove the decimal point and pence, click twice on the [Decrease Decimal] button

The figures should now be displayed as whole numbers. Note that you have only changed the display format; formats don't affect the stored data or accuracy to which calculations are made.
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A wider range of cell formats is available via the [Format Cells: Number] button. This is shown as a small arrow to the right of the word Number (below [Decrease Decimal]). Try using this next:

5. Make sure column B is still selected

6. Click on the [Format Cells: Number] button (the small arrow in the corner of the group)

7. In the Format Cells window, change the Category: from Custom to Currency

8. Set the number of Decimal places: to  0 and choose a currency Symbol: (eg a Euro  €)

9. Choose the last format for Negative numbers:  -€1234 in red

10. Press <Enter> or click on [OK] to apply the format

This produces much the same result as before except that the currency symbol is next to the figures while any negative values will appear in red (you'll see this later). Note that you can also display the Format Cells window by right clicking on a cell or selected range and choosing Format Cells…

11. Reduce the column width by double clicking on the dividing line between the column B and C headings
[image: ]

Format Painter:

Columns C, D, E and F (which you will be using later) also need to be formatted similarly. The simplest way to do this is to copy the format from column B to the other columns.

12. Make sure column B is still selected

13. Double click on the [Format Painter] button on the far left of the Home tab of the Ribbon

You will find that the blocked cells have a moving boundary while the mouse cursor now has a little brush attached.

3. Click on each of the other column headings (ie C to F) in turn or drag across them

4. Click on the [Format Painter] button again to turn it off (the brush disappears)

Only when you enter data into these cells will the new format become apparent.
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16. Finally, move to B1 and retype the original value of  25000

Clearing a Format

Cell formats can sometimes cause confusion to the new Excel user. As an example: 1. Move to cell A7 and type in 25/12 then press <Enter>

Because you forgot the equals sign denoting a calculation, Excel interprets this as a date. 2. Move back to A7 and correct your mistake (type =25/12 and press <Enter>)

You will find that the result is still translated into a date (Excel has assigned a date format to the cell). To display the information as a number you have to clear the format. To do this:

3. Click once on the [Format Painter] to pick up the format of cell A8

4. Now click on cell A7 (the format clears and the number should be properly displayed)

Note that if you click on the [Format Painter] once, you can copy the format to a single cell or range and then the painter is automatically turned off. You can also clear a format via the [Clear] button in the Editing group on the right of the Home tab of the Ribbon.

5.  Finally, press <Delete> to empty the cell - the data isn't needed

Inserting Blank Rows and Columns

Next add a title to your work. Unfortunately, there is insufficient room at the top of the sheet for this so you will first have to insert some blank lines.

1. Right click on the row number 1 and choose Insert from the menu which appears

2. Repeat step 1 for a second blank row

Note: If you right click inside a cell, you can insert (or delete) either a single cell or the whole column/row.

You can also insert (or delete) a column by clicking on a column letter. Try this next:

3.  Right click on the column letter A and choose Insert from the menu - a blank column A will be added

You don’t actually need this column, so delete it:

4.  Right click on the column letter A again but, this time, choose Delete from the popup menu

Inserting rows and columns may seem trivial, but Excel has to adjust any formulae to take account of the changes. For example, the Profit Before Tax formula in B5 now says =B3-B4 instead of =B1-B2. Had it not been changed it would of course be invalid, as B1 and B2 are now empty cells. Note also that though the taxrate has moved (to A12), it is still held in a cell named taxrate. This is one good reason for naming certain cells - you do not have to keep a list (that has to be updated each time you insert a row or column) of which cells hold which fixed values.

2. Finally, enter the title Profit and Loss in cell A1- press <Ctrl Enter> (this will keep the current cell as A1, ready for the next command)

Note that you can also insert and delete rows/columns using the [Insert] and [Delete] buttons in the Cells group on the right of the Home tab on the Ribbon.

Changing the Style of Text
[image: ]
Font:  [image: ]  Font Size:  [image: ]  Bold:  [image: ]  Italic:  [image: ]  Underline:

As in Microsoft Word, you can alter the font, font size and style of your data. For example, the title would look better if it was bigger and bolder.
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1. Check that the current cell is still A1

2. Click on the [Bold] button (or press <Ctrl b>) - the text will become bold

Tip: If you want just part of the text in a cell to be bold/italic etc or a different font, then select the text on the Formula Bar and apply the format to that selection. You can also apply formatting as you type in any text.

Now make the text larger and change the font.

3. Click on the list arrow to the right of the [Font Size] box and choose 14

4. Click on the list arrow to the right of the [Font] box and choose Arial

Note how the text changes automatically as you move up and down the list of font sizes and fonts. You can also right click on a cell for a floating copy of these buttons (instead of using the Ribbon)

Storing Numbers as Text

Next, extend the model over time. Imagine you want to project the profit and loss figures over a four year period, based on some simple assumptions about what is going to happen to income and costs. Firstly, you need some labels to show which year is which.

1.  Move to cell B2 and type  '2008 then move to C2 (press <right arrow>)

Don't miss out the single quote (at the beginning) - this tells Excel that although 2008 looks like a number, it should be treated as text. This will prevent the year 2008 being displayed as €2,008, for example, as the display format for this cell is set to a currency. Another reason for entering numbers as text is that they aren’t then included in calculations (for example, if you summed a column of figures).

2.  Next type  '2009,  '2010 and  '2011 into cells C2, D2 and E2

The Copy Command
[image: ]
Cut:  [image: ]  Copy:  [image: ]  Paste:

Assume that both income and costs will grow by 20% in 2009 from their 2008 figure.

1.  In C3, enter  =B3*120% - press <Ctrl Enter> to carry out the calculation but stay in the cell

Where one formula is essentially exactly the same as another (except that the calculations are being made in a different row or column, on different cells), you can copy it and Excel will automatically adjust it to account for its new position. Assuming costs also rise by 20%, the formula for C4 is almost identical to that for C3, and can be copied across:

4. Check you are in cell C3 then click on the [Copy] button (or press <Ctrl c> or right click and choose Copy from the popup menu) - the cells will be surrounded by a moving border

5. Move down to C4 (press <down arrow>) then press <Enter> - note how the formula which was =B3*120% in C3 has been modified to =B4*120% in C4

IMPORTANT: When pasting formulae in Excel, you don't have to use Paste at all. Instead, you move to destination cell and press <Enter>. This completes the copy/paste process, turning off the moving border and removing the data from the Clipboard. If you use Paste then the moving border remains, indicating that you can Paste again (should you need to). Get used to using <Enter> for a single copy/paste and Paste for multiple ones (use <Enter> for the final one in the sequence).

You can copy a range of cells in the same way. Here, the Profit Before Tax, Tax and Profit After Tax formulae for 2009 are essentially the same as those for 2008:

4.  Drag through the cells required (here from B5 to B7)

The three cells should now be blocked (with a single darker border around them).

5.  Click on the [Copy] button - the cells will be surrounded by a moving border
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6.  Press <right arrow> to move to C5 and press <Enter>

Appropriately modified formulae appear in the cells with the results displayed. Note that you do not have to select a block of cells to paste a range; just paste in the top left cell of the destination area.

Copying formulae (or values) between cells is such a common requirement that Excel provides a special facility (called autofill) for doing this. The key is the cell handle - the small black square at the bottom right corner of the active cell (or range). Try using this for the 2010 and 2011 formulae:

7. The cells to be copied (C5 to C7) should still be selected - if not, drag through them

8. Move the mouse cursor over the small black handle at the bottom right of the selection (in cell C7) - the cursor will change shape to a simple black cross

9. Hold down the left mouse button and drag the handle over the area you wish to fill (across to E7) - release the mouse button and the formulae are copied across

Take great care when using the cell handle to copy formulae. If the mouse cursor is pointing to the edge of the selection rather than the handle, the cells are moved and not copied.

Your screen should now look like this:
[image: ]















Don't worry about the £0's for 2010 and 2011 because, although the formulae are there, there are no income or costs figures in D3, D4, E3 or E4 to work on.

Examine the formulae which underlie the figures by moving the active cell around and looking at the Formula Bar. Notice how the Profit Before Tax formula (which was =C3-C4 in 2009) has changed to =D3-D4 in 2010, and =E3-E4 in 2011. Very occasionally you might want to copy the values themselves rather than the formulae. This you can do via the [Paste Special] button.

Next provide the model with some Income and Costs figures for 2010 and 2011.

10. Work out formulae for D3, D4, E3 and E4 yourself, given the following assumptions:

· in 2010, Income and Costs will increase by 10% over the 2009 values

· in 2011, Income and Costs will increase by 5% over the 2010 values

Hint: Copy the formula from C3 to D3 and E3, amend these then copy down to D4 and E4.

The screen should look like this (see the Appendix or use the links above to check the formulae):
[image: ]
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Realigning Titles
[image: ]
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By default, text is displayed on the left of a cell, numbers (including dates and times) on the right. Your model would look much neater if the year headings (2008, 2009 etc) were in bold text in the centre of the columns and the main title (Profit and Loss) was centred across the figures below.

4. Select row 2 (by clicking on the number 2 on the left hand side)

5. Click on the [Bold] button to make the text bold

6. With the cells still highlighted, click on the [Center] button on the Home tab of the Ribbon

The justification commands are also available via the [Format Cells: Alignment] button – the little arrow on the right of the Alignment group heading on the Home tab. Here you can justify cell contents vertically as well as horizontally. Another option, Wrap text, allows text to flow onto several lines (the row height increases to accommodate it).

Tip: If you want to force text onto more than one line in a cell, hold down the <Alt> key and press <Enter> where you want each new line to begin.

[Merge and Center] is used to centre text across several columns - try this for your main title:

4. Select cells A1 to F1 (column F will be used shortly)

5. Click on the [Merge and Center] button (on the right in the Alignment group)

The title will now appear in the centre of the selected range, even though it is still stored in cell A1. Incidentally, cells B1 to F1 no longer exist. To undo a merge and centre:

6.  Check the merged cell is the active cell then click on the [Merge and Center] button again

Finally, the year headings would look better if they were separated from the main heading. Most users would add extra rows to achieve this but a better answer is to increase the row height:

7. Position the mouse cursor over the division between the Row 2 and Row 3 headings on the left (just like you did when changing the width of the columns)

8. Hold down the mouse button and drag the division down a row

9. Release the mouse button and the row height will be increased


Functions
[image: ]
Insert Function:  [image: ]  AutoSum:

Excel has hundreds of built-in functions which, as in mathematics, are denoted by using brackets after the function name. These can be seen via the [Insert Function] button on the Formula Bar.

5. Move to an empty cell and click on the [Insert Function] button

6. From Or select a category: choose All

7. Scroll down the Select a function: list to get an idea of what's provided

Note that information about any function selected is given at the foot of the Insert Function Window, while additional help is available via the Help on this function link. Don't try inserting any of the functions into your empty cell, just note what's available.

4.  Press <Esc> or click on [Cancel] to close the window



10

Calculating Totals - the SUM Function

Imagine you want to work out four-year totals, so that your model looks like this:
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1.  Type the heading  Totals into cell F2 and press <Enter>

Next you need to add up the figures across each row. One way of calculating this for row 3 would be to use the formula =B3+C3+D3+E3. This works - but imagine you had twenty items to add up, or a thousand! Instead, you can use a function to work out the value. To specify a function you type its name then, in brackets, the cell or range of cells to which it is to be applied. To signify a cell range, a colon is used to separate the starting cell from the end cell.

2.  In cell F3 type  =SUM(B3:E3) - press <Enter> to carry out the calculation

The SUM() function (and other commonly-used ones) is also available from the [AutoSum] button. Using this, you can calculate the missing total figures in one go:

3. Select F4 to F7

4. Click on the [AutoSum] button on the right of the Ribbon - the remaining totals are filled in

Sometimes Excel guesses the range of cells to be summed incorrectly. The default is to total down a column rather than across a row. See what happens by recalculating the total in F7.

5. Move to F7 and press <Delete> to clear the cell

6. Click on the [AutoSum] button - note the range is incorrect

7. Drag through the correct cells (B7 to E7) to amend the range then press <Enter> to complete the calculation

Orders and Gridlines
[image: ]

Borders:

Another format you can apply to a range of cells (or single cell) is to put a border round them. For example, you might want your screen to look like this:
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1. Move back to Sheet1 by clicking on its tab on the left at the foot of the screen

2. Select cells B3 to F7 (include the Totals this time)

3. On the Home tab on the Ribbon, click on arrow on the right of the [Borders] button

4. Choose a Thick Box Border

5. Next select F3 to F7 and add a Left Border in a similar way

Removing the Gridlines

The gridlines are the grey lines separating the rows and the columns. Excel gives you the choice as to whether you want them displayed or not. To turn them off:

3. Move to the Page Layout tab on the Ribbon

4. In the Sheet Options group uncheck the View option in the [Gridlines] button

5. To turn them back on, repeat step 2 as above

Note: this only affects whether they are displayed on the screen. If you want them to be turned on/off when printed, turn on the Print option below View. The default is that they aren't printed.


Printing your Work

General information about printing on IT Services machines is available in the Quick Guide to Printing document. In Excel, you should also be familiar with the options available in Page Setup.




[bookmark: page16]Print Preview

Before printing your work, you should preview it. This is particularly important in Excel if you want it to fit neatly onto the page. In a minute you will look at the Page Setup but first:

1.  Click on the [Office] button and choose Print followed by Print Preview

Ideally, it would look better to have the paper sideways and you wouldn't want all of the data shown (the taxrate cell, for example, shouldn't appear).

2.  Click on [Close Print Preview] to quit Print Preview

Page Setup

In Page Setup you can control how your results will appear on a printed page, including whether any column headings are repeated on each page (as a header row).

1. On the Page Layout tab on the Ribbon, click on the [Page Setup] button (the arrow to the right of the Page Setup group heading)

You will see various options grouped under four tab headings. Several settings are exclusive to Excel. The following exercise modifies some of these to show you how they work:

2. Check you are viewing the Page tab

3. Under Orientation choose [Landscape] – ie sideways

4. Under Scaling set Adjust to: to  180 - this will magnify your data to fill the page

Note that you can always force your work to fit on a single page (or more than one, if you require it) Note also that the Paper size: should be A4 if you are printing from an IT Services machine.

5. Move to the Margins tab

6. Click on both [Horizontally] and [Vertically] under Center on page

7. Move to the Header/Footer tab

8. Click on the list arrow attached to Footer: and choose Test (to add the file name)

9. Next, click on [Custom Footer…] – the following dialog box appears:
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Note that Excel has coded the file name as &[File]. This is called a Field Code and will display the current name of the file if you save it with a different name. Other codes are available via the icons provided (read the text above to work out which is which). Try adding a page number on the right:

10. Click inside the Right section then on the second icon (the # sign) - &[Page] is added

11. Click on [OK] and note the page number now shows in the preview of the footer

The Sheet tab lets you define the area to be printed, letting you omit cells you don't want (here, you don't want the taxrate displayed – one way to do this would be to make the font colour white but setting the print area is better). It also controls whether [Row and column headings] are printed

12. Move to the Sheet tab
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[bookmark: page17]13. In the Print area: box type  A1:F7

Tip: Sheet also lets you set Print titles - rows and/or columns which are automatically repeated on each page for data which extends over several pages. To set this to the first row, for example, use 1:1; for the first two columns use A:B – type the range or select the rows/columns to fill these in.

Within Page Setup you have links to Print and Print Preview.

14. Click on [Print Preview] to view the modifications

15. Click on [Close Print Preview] to return to the worksheet


Leaving Excel

To quit from Excel:

· Choose Exit Excel from the [Office] button

· Press <Enter> for [Yes] when asked whether you want to save the changes to test.xlsx.

























	








UNIT-IV
Introduction

Microsoft PowerPoint is widely used for making professional quality presentations in a variety of formats, including on-screen computer slide shows, black-and-white or colour overheads, and 35mm slides. You can also use it for speaker's notes and audience hand-outs.

In addition, PowerPoint can be used as a drawing package for preparing pictures, forms, posters and leaflets (for example, we use it to produce our ITS Quick Guides). If you are not familiar with the drawing tools, have a look at  Microsoft Office 2007 The Drawing Tools.


Running an Example Presentation

Start by opening an example file to see how a presentation looks and what PowerPoint can do. If you are not using an IT Services computer, then the presentation can be run by clicking on the link at Step 3, below.

3. Click on the Start button in the bottom left corner of the screen and choose My Computer 

4. Double click on the User (D:) icon then repeat this on the Training folder icon 

5. Finally, double click on the  example.pps icon then follow the on-screen instructions 

6. [Close] Windows Explorer after the presentation has finished 

Note that the example presentation ran immediately on opening the file. This is because it was saved in a special PowerPoint Show format. Presentations saved in this format will even run on a computer which doesn't have PowerPoint installed. You’ll learn more about this later.


Starting Microsoft PowerPoint

To load Microsoft PowerPoint:

6. Click on the Start button again but this time choose All Programs 

7. From the sub-menu choose Microsoft Office then Microsoft Office PowerPoint 2007 

Tip: If you use PowerPoint quite frequently, it's worth adding it as an icon on the Desktop. To do this, repeat the above steps but, at the last step, right click (ie press the right mouse button) and choose Send To followed by Desktop (create shortcut). To load PowerPoint in future, simply double click on the desktop icon.

You are presented with the screen below, ready to enter information onto your first (title) slide:
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The main part of the screen is divided into two sections. The main section shows the current slide, while on the left, slide miniatures appear, allowing you to see the current slide in its context.

In the very top left corner of the screen is the [Office Button] which can be used to open or print your presentation. To the right of this is the Quick Access Toolbar which contains icons to common commands, eg save and undo. Below this is the Ribbon, with tabs along the top. Each tab has a set of icons which are used to give instructions to PowerPoint. Currently the Home tab is displayed.

At the very bottom of the window, is the Status Bar. This shows various information, eg which slide you are currently looking at (here you are on slide 1) and the language you’re working in. On the right-hand side of the Status Bar are icons to change the view of the slides and to zoom in or out.


Creating a New Presentation

You are going to create a presentation, consisting initially of 6 slides, about the training offered by IT Services. It's best to follow the notes exactly, step by step, though you can use your own information, if you prefer.

It's important whenever you create a presentation that you give full consideration to your audience. In particular, don't try to crowd too much information on each slide and make sure that the text is big enough to be clearly readable (especially for those with poor eyesight or similar disabilities). Throughout these notes, mention will be made of good practice so far as accessibility is concerned.

Entering Text onto the First Slide

The first slide has the layout for a Title Slide (usually you start a presentation with a title slide, though you don't have to). The layout has two boxes with a dotted frame. These boxes are called placeholders. Those provided here can contain text. You will be meeting other types of placeholder later. Instructions on using each type of placeholder appear within its frame.

1.  Click on Click to add title to activate the top main title placeholder and type  IT Services

Note that the default font is Calibri (Headings), the size is large (44 pt), and the title is centre-aligned in the placeholder. Calibri is a sans-serif font; these are recommended for good accessibility

2.  Click on the lower placeholder, Click to add subtitle, and type  Computer Training

If you find the text on the screen a bit small to read then increase the magnification using the zoom facility in the bottom right-hand corner of the Status Bar. Use the slider or click on the [Zoom level] (%) button.

Saving a Presentation

It's a good idea to save your work at regular intervals whilst you are working on it rather than wait until you have finished the last slide. For example, you could save every 15 minutes or after completing each slide.

7. Click on the [Office Button] in the top left-hand corner and choose Save (or use the [Save] button on the Quick Access Toolbar) – better still, use <Ctrl s> from the keyboard 

The File name: has already been set for you (PowerPoint uses the main title you entered on the first slide - IT Services) - you can change this here if you want. PowerPoint automatically adds a .pptx extension.

2.  Ensure that Save in: is set to My Documents then press <Enter> for [Save]

If you wish to save your presentation in the older 2003 format, change Save as type to PowerPoint 97-2003 Presentation (*.ppt). This would make it easier for anyone who has an older version of PowerPoint to open and edit the presentation. Note, however, that if a document is saved as an earlier version then some new features added to PowerPoint 2007 may not be saved (you are warned what these are).

It’s also worth noting some of the other Save as type options such as .pps or .ppsx for PowerPoint slideshows;

.pdf for a non-editable copy in PDF format; .png, .gif or .jpg for graphics format; and .html for web pages.
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Adding New Slides

You are now going to add the next slide:

4. Click on the [New Slide] button on the left of the Home tab in the Slides group (click on the icon not on the words New Slide) or simply press <Ctrl m> 

A new slide appears in a different slide layout from the first called Title and Content. There are several different slide layouts available (which you can get to if you click on the words New Slide rather than the icon).
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5. Click in the Title placeholder (where it says Click to add title) and type  Introduction 

6. Click in the Content placeholder (where it says Click to add text) to activate it 

Tip: You can jump between placeholders by pressing <Ctrl Enter> on the keyboard.

3. Type in the following details, pressing <Enter> after each bulleted item: 

Different Ways of Learning 

Training Materials 

Training Sessions 

Training Topics 

Changing the Look of Your Text on the Slide
[image: ]
Bullets  [image: ]  Font  [image: ]  Font Colour  [image: ]  Change Case  [image: ]  Line Spacing

There are a number of ways that you could change the look of your text on this slide. You could, for example:

10. change the bullet point character 

11. use a different font 

12. change the font colour 

13. change the case (upper, lower) of the text 

14. increase or decrease the line spacing between the bullet points 
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IMPORTANT: if you wanted to apply all or some of the above changes to every slide in a presentation, you would need to make the changes on the Master Slide. It’s best to do this before you start typing your words onto the slides. You will look at Master Slides later.

To make changes to all your text you need to have the placeholder selected:

6. Press <Esc> (in the top left corner of the keyboard) – the placeholder handles are displayed 

7. On the Home tab in the Paragraph group, click on the down arrow next to the [Bullets] button 

8. Choose the bullet character required (eg the tick marks or checkmark bullets) 

You can also get to further choices after doing step 2 above by choosing Bullets and Numbering… at the bottom of the list. Here there are [Customize...] and [Picture...] buttons that allow you to choose non-standard characters and pictures as bullets. Take care when choosing non-standard characters as they may result in poor accessibility - it's best to stick to those offered here, unless you know what you are doing. Note also that the size of the bullet point can be changed relative to the text, as can its colour.

To use a different font:

4.  Click on the down arrow next to [Font] button on the Home tab, and choose the font you want

Remember that sans-serif fonts (eg Ariel) are best. Next, to change the font colour:

5. Click on the down arrow next to [Font Colour] button in the Font group 

6. Click on the square of the colour that you want (or click on More Colors… and select a colour from there then press <Enter> for [OK]) 

To change the case of the text, eg turn all the letters to UPPERCASE or to lowercase:

7.  Click on the down arrow next to [Change Case] in the Font group and choose the case required

Finally, to change the line spacing of the bulleted points:

5. Click on the down arrow next to [Line Spacing] button in the Paragraph group on the Home tab 

6. Choose the line spacing required, eg 1.5 for one and a half line spacing 

Note: the last item in the list, Line Spacing Options…, gives you access to further settings, eg to change the spacing before or after a paragraph.

To change the bullet point symbol, font, font colour or case on a particular bullet point, simply select that line (drag through it or click three times on the mouse button) then carry out the instructions as above. Note that you can also use the [Format Painter] (the paint brush icon in the Clipboard group on the left of the Home tab) to copy the format of one list entry to another (or to the whole list).

You don’t have to have bulleted points at all, if you don’t want them for a particular line. To turn them off:

1. Click on the line you don’t want bulleted (here, click on the first line in the list) 

2. Next, click on the [Bullets] button (click on the icon itself, not the list arrow) 

Your bullet point should now have disappeared. Note, however, that if the text stretches onto a second line, that would still be indented. You would need to change the paragraph settings by right clicking on it and choosing Paragraph…. Under Indentation set Before text: to 0 and change Special: from Hanging to (None).

12. End by redisplaying the bullet – press <Ctrl z> for [Undo]

Changing the Layout to Include a Picture
[image: ]



What if you decide that you would like to add a picture to illustrate this slide? The easiest way to do this, keeping what you've done already, is to choose a slide layout which includes a picture placeholder.

1.  Click on the [Layout] button in the Slides group on the left of the Home tab

You have various options as shown below:
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2.  In the second row, click on [Two Content] – a new placeholder appears on the right

Adding a Picture from the Clip Art Gallery
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This new placeholder has content icons (in the centre) as well as the usual bullet points at the top. These let you add a Table, Chart, SmartArt, Picture, Clip Art or Media Clip respectively. To insert some Clip Art:

1. Click on [Clip Art] (the second icon in the bottom row)– a Clip Art pane appears on the right 

2. Type  computer into the Search for: box at the top of the pane then press <Enter> for [Go] 

3. A Microsoft Clip Organizer prompt appears - click on [Yes] for 1000s of additional clip art images, 

4. Click on the picture you want, to add it to your slide 

Your chosen clip art will be inserted, and an extra Picture Tools Format tab is added to the Ribbon:
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The buttons on this tab allow you to change things like the picture's brightness, contrast and colour (in the Adjust group). The crop tool (in the Size group) lets you cut off unwanted areas by trimming down the edges of the picture. You can experiment with these options if you like. Clicking on the slide, away from the clip art, changes back to the Home tab. When you click on the clip art again, the Picture Tools Format tab reappears.

With the clip selected, you can easily change its size, position or rotate it. To change the size:

6. Point the cursor to one of the white circles or squares (border handles) around the picture then hold down the mouse button and drag the handle out (to make it bigger) or in (to make it smaller) 
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2. To reposition the image, point inside the picture placeholder then hold down the mouse button and drag it to the required position (or use the <arrow keys> on the keyboard) 

3. To rotate the clip, move the pointer over the green circle then hold down the mouse button and move the mouse in a circular motion 

Tip: To do the above steps more accurately, you can use the [Height] and [Width] buttons in the Size group and the [Rotate] option in the Arrange group on the Picture Tools Format tab.

It’s easy to change the clip if you decide you prefer another:

12. Click on the clip to select it then press the <Delete> key – the content items reappear 

13. Click on the [Clip Art] icon (the pane closes) then click on it again and choose a new clip as before 

Applying a Theme

A theme can make your presentation look more professional. The default theme uses black text on a white background. This is somewhat boring and simple, but good for accessibility. To see the different themes:

1.  Click on the Design tab – the ribbon changes to show a number of different themes:
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2. Move the mouse pointer over any of the themes – the current slide will display the chosen theme 

3. For more schemes, click on the [More] button at the foot of the scroll bar on the right of the themes 

4. Click on your preferred theme - both slides should now display the new theme 

Tip: If you right click on a slide you can choose whether to Apply to All Slides or Apply to Selected Slides.

Usually, all the slides in a presentation will have the same theme but, if your presentation is split into different sections, then you could consider using a different theme for each section.

Most of the themes use contrasting text and background colours to maximize accessibility, ie light text on a dark background or dark text on a light background. This helps to make the text clearer and easier to read. Note that some themes contain pictures or patterns that could cause viewing problems for certain people. You can always apply a different theme later if you decide the current one is unsuitable.

5.  Press <Ctrl s>to [Save] your presentation again

Creating Further Slides

Your first two slides should look something like this:

slide 1  [image: ][image: ] slide 2

Create the following slides in the same way (going from left to right, downwards), choosing the correct layout for each as you proceed:
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	slide 3
	slide 4

	slide 5
	slide 6

	A few points to note:
	


[image: ]
· Slide 3 (Different Ways of Learning) is identical to slide 2, apart from the text. You could duplicate slide 2 and then modify the text on the new slide. To do this, right click on the slide 2 miniature and choose Duplicate Slide from the pop-up menu 

· On slide 4 (Training Topics), a Two Content slide layout is used. In each content box, there are some sub-bullet points below the two main ones (ie Microsoft Office and Other Programs). To create these: 

1.  Having typed the main list item, press <Enter> to add a new main bullet point 
[image: ]
Increase List Level

2. Press <Tab> or click on the [Increase List Level] button to set a sublevel bullet (<Shift Tab> or [Decrease List Level] can be used to move back to a higher level) 

3. Type in the required text, press <Enter> and then type in the next sub-bullet point 

· For slide 5 (Training Sessions), a Title and Content slide layout is used. Within the main content box, the [Insert Chart] icon was used to choose a pie chart. The original data in the chart was changed through the Excel table that appears, and the [Quick Layout] button on the Chart Tools Design tab was used to get percentages onto the chart 
[image: ]
Insert Chart

· On slide 6 (Training on Office 2007), a Title and Content layout is used to produce an organisation chart. Within the main content box: 
[image: ]
Insert SmartArt Graphic

1. Click on the [Insert SmartArt Graphic] icon 

2. Within the Choose a SmartArt Graphic window, click on Hierarchy on the left 

3. Select the first Organization Chart layout on the right and click [OK] 

4. Enter the information that you want in the boxes - to delete/add boxes or shapes right click on them then choose the appropriate option from the shortcut menu 

Remember to save the latest version of your presentation - press <Ctrl s>. At this point, it’s also worth doing a spell check on your presentation – to do this, move to the Review tab and then click on the [Spelling] button on the left.
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Guides, Gridlines and Rulers

When creating your slides, the placeholders have largely been left in their default positions. Often, people move them around slightly, usually to cram extra information onto a slide. This isn’t good practice – not only do you end up with too much on a slide but the consistency of layout is lost. If you do need to do this then it’s better to do so on the Master Slide (see later) but it also helps if you display the Rulers and Guides. To do this:

1. Right click on a slide background and choose Ruler – a ruler appears at the top and left 

2. Right click again and this time choose Grid and Guides… - the following dialog box appears: 
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3.  Turn on Display grid on screen and Display drawing guides on screen – press <Enter> for [OK]

The guides are the lines which split the slide exactly into quarters, while the default grid is shown by dotted lines 2cm square. Each dot represents 0.4cm. Objects are lined up with the grid; to see this:

4. Click on the Title placeholder (Training on Office 2007) then press <Esc> 

5. Use the arrow keys to move the placeholder slightly – each key press moves it 0.2cm exactly 

6. Move the placeholder back to its original position – or use <Ctrl z> to [Undo] the changes 

7. To hide the grid, repeat step 2 then turn off Display grid on screen – press <Enter> for [OK] 

Knowing about the grid and guides will help you position placeholders exactly but, better still, don’t be tempted to move them at all. To learn more see  Microsoft PowerPoint 2007: Positioning Objects.


PowerPoint Views

It is possible to view your presentation in a number of different ways. To switch between views:

· Either: Click on the View tab at the top and choose one of the first 4 icons on the ribbon below 

· Or: Use the buttons at the bottom right of the window (just to the left of the Zoom options) 

The table below gives a better idea of what the 3 different view buttons give you:

	
	View
	
	On Screen
	
	Use To
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	Shows the slides in miniature, the
	
	Edit contents of slides; try out
	
	

	
	
	
	
	
	
	
	

	
	Normal View
	
	slide in full, and speaker's notes
	
	animation effects
	
	

	
	
	
	underneath
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	Shows a miniature of each slide in
	
	Add, delete and move slides;
	
	

	
	Slide Sorter
	
	the current order
	
	rehearse timings
	
	

	
	
	
	
	
	
	
	

	
	
	
	Plays the presentation on screen
	
	Practise presentation
	
	

	
	
	
	
	
	
	
	

	
	Slide Show
	
	from the current slide
	
	
	
	

	
	
	
	
	
	
	
	


[image: ][image: ][image: ]
From the View tab on the Ribbon, there are also the following options:

· Slide Show icon runs the presentation, similar to the button, but from the first slide 
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· Notes Page gives a view with more space for speaker's notes under the slide. Here, you can type up exactly what you plan to say for each slide. The notes can then be printed out so you have them to consult when giving an actual presentation 

· Zoom... changes the magnification – Fit to Window displays the whole slide in the available space 

Moving through the Slides

There are several ways to move between slides, when preparing a presentation in Normal view:

· Click on the required slide miniature in the left-hand section of the screen 

· Use the scroll bar on the right of the main display - drag the indicator up or down (the current slide details are displayed as you do so) 

· Use the double arrow buttons ([Previous Slide] and [Next Slide]) at the foot of the scroll bar 

· Press the <Page Up> or <Page Down> keys 

· Use the <up arrow> or <down arrow> keys 

Decide which of the above best suits you and then try moving through your current presentation.

Deleting and Hiding Slides

It's easiest to delete slides in Slide Sorter view (though you can also do so in Normal view), especially if you have a lot of slides to deal with:

1. Click on the [Slide Sorter] button (either on the Status Bar or View tab) 

2. Click on the slide to be deleted (eg slide 4, Training Topics) then press the <Delete> key 

3. To reinstate the deleted slide (you were just practising), press <Ctrl z> for [Undo] 

You might want to hide a slide – for example, if you are giving the presentation to a different group of people for whom that slide is not appropriate. When a slide is hidden it remains within the PowerPoint file, but is not displayed during the presentation. To hide a slide:

4. Right click on the slide to be hidden (in Normal View you have to right click on the slide miniature) 

5. From the shortcut menu choose Hide Slide - you’ll find that the number underneath the slide now has a line through it indicating that it’s hidden 

6. To show the slide again, just repeat steps 4 and 5 

Tip: To display a hidden slide when running a show, press the <h> key on the keyboard.

Changing the Order of Slides

As with deleting slides, the easiest way to move slides around is within Slide Sorter view:

1. Make sure you are in Slide Sorter view 

2. Point to the slide you wish to move then hold down the mouse button and drag the slide to the new position - a vertical line indicates where it will be dropped 

3. Release the mouse button when the slide is correctly positioned 

Note: In Normal view you can change the order by moving (drag & drop) the slide miniatures up and down the left panel. In both views, you can also cut/copy and paste slides via the Clipboard.

Creating Notes Pages

In Notes Page view, you can create notes that you can print out and use as a guide during your presentation. Each printed page contains an image of the corresponding slide and its notes.
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1. Select one of your slides then, on the View tab, click on the [Notes Page] icon 

2. Click in the notes placeholder below the copy of the slide (where it says Click to add text) 

3. To see what you are typing, click on the [Zoom] icon on the ribbon, select 100% and click [OK] 

4. Type in some notes for the speaker, for example:  Remember to say... 

5. Close the notes page view by clicking on the [Normal] button (on the Status Bar or View tab) 

6. Press <Ctrl s> to save any changes to your file 

Note: You can also add notes in Normal View (where it says Click to add notes at the bottom of the slide).


Running the Presentation

Once you have made the slides for a presentation, you can run it as a slide show. If you use the [Slide Show] button on the Status Bar then the show will begin from the currently-selected slide; if you use the icon from the View tab (or press <F5>) then the show starts from the first slide. Note that you can also go to the Slide Show tab on the Ribbon and choose either [From Beginning] or [From Current Slide].

Tip: You can also run a presentation from the current slide using the key combination <Shift F5>.

1. Click on slide 1 to ensure the show starts from the very beginning 

2. Click on the [Slide Show] button (or use <F5> or Slide Show from the View tab) 

3. To move forward one slide, click the left mouse button 

Note: <Enter>, <n>, <right arrow>, <down arrow> or the <spacebar> on the keyboard also work. 4. To move back one slide, press the <left arrow> key (or <p> or <up arrow>)

You can also click the right mouse button to display a popup menu. This presents you with a number of useful tools, including:

· Next and Previous to move back/on one slide, respectively 

· Last Viewed - useful if you have jumped to another slide (out of sequence) 

· Go to Slide - to jump to another slide in the presentation 

Note: you can also jump to a particular slide by typing in its number and pressing <Enter> 

· Screen - gives you control over the display 

· Black Screen or White Screen temporarily suspends the presentation (press any key to show it) Note: you can also activate these by pressing <b> or <w> on the keyboard while running a show 

· Switch Programs displays the Windows Task Bar 

· Pointer Options - annotation pens for scribbling over your presentation 

· Choose Ballpoint Pen to change the arrow pointer to a pen which can be used to draw on the slide - choose Felt Tip Pen for a wider pen or Highlighter to highlight text 

Note: to activate the pen press <Ctrl p> while running a show; <Ctrl a> redisplays the pointer 

· Choose Ink Color to change the colour of the pen 

· Use Eraser or Erase All Ink on Slide to remove any pen marks you may have drawn 

· Use Arrow Options and Automatic to set your pen back to a pointer; Hidden hides the pointer Note: pressing <a> while running a presentation hides/shows the pointer 

· Help gives information about other key combinations you can use during the show 

· End Show - use this if you need to finish early or it's been a disaster! Note: to leave the slide show at any other time, press the <Esc> key 

After the last slide, PowerPoint displays a black End of slide show screen. If you have added ink annotations to your slides you are asked if you want to keep them (the original slides will be changed if you do); you are then returned to the previous view. See the  Running Presentations in PowerPoint for further information.
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Animating your Presentation

Presentations are greatly improved by adding animation. PowerPoint gives you a wide selection of built-in animations, both when moving between one slide and the next and within each slide (as you introduce points in a list, for example).

Slide Transitions

Instead of simply moving abruptly from one slide to another during a presentation, slide transitions allow slides to dissolve into each other, using a variety of different special effects. These can make your on-screen presentation look even better and more professional, but don't get too carried away!

5. Check you are in Normal view and that the first slide is selected 

6. Move to the Animations tab at the top to show the following ribbon: 
[image: ]




Across the middle of the ribbon, you’ll see certain transition effects. As you move over each one, you’ll see the transition effect on the slide. Just to the right of these is a vertical scroll bar – use the up and down arrows on the scroll bar to change the set of transition effects that are showing (there is also a More arrow underneath that will show you all the different transition effects in one window).

3.  Choose one of the transition effects for the first slide

Note that a small star symbol appears to the left of the first slide miniature - this indicates that a transition has been setup on this slide. Next, explore the options in the Transition to This Slide group on the ribbon:

4.  Set the Transition Speed: of the transition effect to Medium or Slow to see the effect more clearly.

You can also set up a Transition Sound: but note that the speakers have been disabled on the ITS Lab PCs.

Another useful feature moves on a slide automatically (without you having to click the mouse button):

8. Under Advance Slide, set the next slide to appear Automatically After a set number of seconds 

9. Move to the next slide and repeat steps 3 to 5, choosing different effects 

10. Finally save your presentation (press <Ctrl s>) then run it (<F5>) to see the effects - press <Esc> when you've seen enough 

Having different transition effects between slides may add interest but it isn’t good practice. It distracts from the talk and isn’t good for accessibility. It’s best to stick to one transition throughout (and only use a different one for effect, if you need to). To standardise the transition:

1. Remove the current effects by choosing [No Transition] (the first one in the list of available effects) then click on the [Apply to All] button 

2. Next, choose your preferred transition (repeat steps 3 and 4) then click on [Apply to All] 

3. Finally, repeat step 7 to see the effects 

Animation Schemes

PowerPoint allows information on your slides to appear one item at a time. This stops your audience from reading ahead of you, making them concentrate on each point individually. Try the following to animate your bullet points:

4. Click on a slide with a bulleted list on it (eg slide 2) and make sure that the Animations tab is still showing on the Ribbon 

5. Click within the bullet point area on the slide and then click on the list arrow next to No Animation in the Animations group : 
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Only a few animation schemes are listed. Some bring in all the bullet points together, eg Fade All At Once, while others bring them in one by one, eg Fade By 1st Level Paragraphs. As you move the mouse over the list, you are shown what each animation looks like on the slide. Try setting up various animations for your slides:

· From the list of animations choose one of them, eg Fly In By 1st Level Paragraphs 

· Repeat steps 2 and 3 for another slide with bullet points, choosing a different animation 

Tip: As with slide transition, it isn't a good idea to use too many different animations as they can distract the viewer. Always bear accessibility in mind and avoid some of the more 'exciting' animations.

To see more of the available animation schemes and to get to further animation options:

3. Choose one of the slides with bullet points that you’ve already animated and click on the slide title (or a picture if there’s one on the slide) 

On the right-hand side of your PowerPoint window, the Custom Animation Task Pane should be showing (this can always be displayed by clicking on the [Custom Animation] button in the Animations group):
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4. Click on the [Add Effect] button followed by Entrance from the submenu and then More Effects... 

5. Choose an entrance effect (they range from Basic to Subtle to Moderate to Exciting!) then click [OK] 

6. Click the [Play] button to check that the changes you have made look correct 

To change the animation order:

9. Click on the object you want to change then use the [Re-Order] buttons to move it up or down the list - click on [Play] again to check the animation is now correct 

10. Finally, save your presentation (press <Ctrl s>) then run it from the first slide (press <F5>) 

Tip: You can also set up Emphasis and Exit effects and Motion Paths - for example, after bringing a picture into the slide, you may want to emphasize it by making it grow in size. When the slide is finished, you can get the picture to exit along a particular motion path. This is all done via the [Add Effect] button (as step 6, above).
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11. End by closing the Custom Animation Task Pane


More Advanced Features

Adding a Footer, Date and Slide Number to your Slides

You can add the following further information to the bottom of each slide:

· the footer is often used to show your name, the presentation title or copyright information 

· the date can show either the date the presentation was last saved or the current date 

· the slide number 

To add information at the bottom of your slides:

1.  Move to the Insert tab on the Ribbon then, in the Text group, click on [Header & Footer]
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2. Turn on the Date and time option - Update automatically will refresh the date to show today’s date whenever you open the presentation and also allows you to choose from a range of display formats 

3. To add slide numbers, turn on Slide number 

4.  To add footer text, turn on Footer and type your text (eg  IT Services Computer Training)

5. You probably won’t want any of this to appear on your Title Slide so turn on Don't show on title slide 

6. To add this information to all of the slides, click on [Apply to All] 

You should find that all of your slides, apart from the first Title Slide, now have some information at the bottom. If you want to remove this information from certain slides:

7. Select these slides (use <Ctrl click> to select more than 1 slide) 

8. Move to the Insert tab then click on [Header & Footer] in the Text group 

9. Clear the check boxes for information you don't want shown then click on [Apply] 

If you want to change the look of your information at the bottom of all the slides, eg font or colour, or you want to move it to a different position on the slide, then you have to make the changes on the Slide Master.
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[bookmark: page15]Master Slides

Master slides are very important as they control the layout of your whole presentation. They allow you to create your own slide template which is applied to every slide. This is useful if you want to put your own logo, picture or even just your name in the same place on each slide.

1. Move to the View tab then click on the [Slide Master] icon in the Presentation Views group – a window similar to that below appears: 
[image: ]























A Slide Master tab is displayed on the Ribbon indicating that you are in the Slide Master view. 2. Click on the first slide miniature on the left

This is the Slide Master which is used by all the slides – any changes you make here are applied to the whole presentation. The slide miniatures below are all the usual slide layouts that are available, some of which are being used by certain slides. To make changes just to a specific layout, you make them on that custom layout.

To change the look of all the information at the bottom of each slide:

3.  Select all the footer placeholders by holding down <Ctrl > and clicking on each in turn

Tip: An alternative method is to use the mouse to draw a selection rectangle over the placeholders – hold down the mouse button and drag over them (the rectangle must enclose the whole placeholder)

4. Move to the Home tab and use buttons in the Font group to change the format, eg font size 

5. To change any placeholder's position, click on the edge (or, more easily, click on it then press <Esc>) and use the <arrow_keys> to move it to its new position 

6. To see the changes to all the slides, move to the Slide Master tab and [Close Master View] 

7. Save your presentation - press <Ctrl s> 

Other things which you may wish to set up on the master slide (or a custom layout) include:

· Adding a picture or image - to change the background colour see Changing the Theme below 

· The default font and font sizes for the text and title styles 

· The bullet point characters for the five bulleted list levels 



[image: ]Changing the Theme

Themes, like slide masters, play an important role in PowerPoint and should always be used when developing more advanced presentations. Within a theme, you can change the colours, fonts and effects that are used.

Each colour theme is a palette of 8 colours which are used for particular elements in your presentation - eg the background, text and hyperlinks. Rather than change a colour for particular elements on each slide or on the Master Slides, you should reset it in the colour theme - it is then applied to all your slides and Masters automatically.

PowerPoint has several pre-defined colour themes, which are specifically designed to give a palette of colours which work together to give clear and interesting presentations. You will find that different themes have different pre-defined colour themes:

1. Click on the Design tab – the ribbon changes to show a number of different themes 

2. To the right of the themes is a [Colors] button –click on this: 

3. Move the mouse over the various colour themes to see a preview of them 

4. To create your own colour theme, click on Create New Theme Colors... at the bottom – the Create New Theme Colors window appears: 
[image: ]























This details the different elements and the colour used for each, as shown in the Sample on the right. There are two pairs of text/background colours – for example, Dark 1 text appears on a Light 2 background.

5.  Click on the arrow next to the Dark 2 Text/Background to modify it – note the change to the Sample

Take care when changing the colours not to reduce accessibility. Normally, you would reset all the colours in the theme as required then give your theme a Name: so you can use it on other presentations. Here:

6. Click on [Reset] to reverse the change to the dark background 

7. Finally, click on [Cancel] to return to your presentation with your original colour theme 

In the Background group on the right of the Design tab is a [Background Styles] button – this can be used to choose a different slide background and, through the Format Background… option, one can fine tune the background or set it to a picture. See Microsoft PowerPoint 2007: Themes for more information.
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Printing from PowerPoint

Choosing a Slide Format

If you intend to use PowerPoint for anything other than on-screen slideshows, you will need to set up the size of the slides you are producing.

1. Move to the Design tab then click on the [Page Setup] icon on the left in the Page Setup group - the following dialogue box appears: 
[image: ]












2. Click on the list button for Slides sized for: 

· On-screen Show - the default, for on-screen slide shows (there are a few different sizes) 

· A3 and A4 Paper - customized for standard A3/A4 format 

· 35 mm Slides - customized for production of 35mm slides 

· Overhead - customized for overhead transparencies 

· Banner - customized for banner headings, eg on a display board 

· Custom - specified paper size. For producing Research conference posters, see  Design & Print  Studio Template downloads (only staff can access this page) 

3. Having seen how this works, here click on [Cancel] 

Printing the Presentation

You can print any part of the presentation - the slides, notes or handouts for your audience.

1.  Click on the [Office Button] in the top left-hand corner and choose Print

The default printer for lab PCs (\\viprn1\ITS-A4B&W) is for black and white; for colour hard copy select \\viprn1\ITS-A4COLOUR using the list arrow attached to the Name: box

2. [bookmark: page19]If necessary, specify the required Print range and Number of copies 

3. In the Print what: box choose what you want to print from the 4 choices: 

· Slides - prints one slide per page 

· Handouts - lets you print several slides (1, 2, 3, 4, 6 or 9) on a page which saves paper if you want to distribute copies of your presentation to your audience 

· Notes Pages - prints a page containing the slide in miniature plus any extra notes you typed in - use this for your own copy of your presentation 

· Outline View - prints out just the text on the slides 

Note that Outline View isn't covered in these notes. Some people use it to make changes to text in preference to Normal View as you don’t have to move to a slide to edit it. To see how this works, click on the Outline tab above the slide miniatures (in Normal View)

4.  Click on [Preview] to check all is okay

Normally, you would now [Print...] it but here:

5.  Click on the [Close Print Preview] button to close the Preview window


Saving Embedded Fonts

If you have chosen to use non-standard fonts for your presentation (eg the special fonts Rdg Vesta and Rdg Swift, built into the recommended University templates for use by staff) then you might find your slides have changed slightly when you run your presentation on a computer without them installed. You can get over this by saving your file (or PowerPoint show) with the fonts embedded. To do this:

1. Click on the [Office Button] and choose Save As 

2. In the Save As dialog box, click on [Tools] in the bottom left corner and choose Save Options… 
[image: ]














3.  Turn on Embed Fonts in the file (the bottom option) then click on [OK] and [Save] your file


Closing the Presentation

You have now finished your introduction to PowerPoint.

1. Save the latest version of your PowerPoint presentation by pressing <Ctrl s> 

2. To close PowerPoint, click on the [Office Button] then on [Exit PowerPoint] 

Tip: A quick way to close any Office application is to press <Alt F4>; <Ctrl F4> can be used to close a file.
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